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Welcome to another issue of Full Circle!

It's March 2012, and that can mean only one thing: it's our birthday next month! It was
in the showery month of April that the first issue of Full Circle was released. Expect
next month's issue to, I hope, contain free party hats and a reflective article or two.

But back to this month. We've got the usual Python and LibreOffice articles, an article on
making a USB stick, one on adjusting the virtual disk size in your VirtualBox machine, and an
article on how to create your own greeting cards in LibreOffice. If you've ever accidentally
deleted something important then you should read Charles's Linux Labs article on Foremost
for recovering deleted files. Ubuntu Games takes a bit of a detour with Riku discussing SNES
emulation, while Jennifer interviewed the makers of Tomes of Mephistopheles. For those of
you fighting with Unity, you might want to read My Story this month, which talks about an
application called MyUnity which lets you easily configure Unity.

If you haven't checked out our website recently, you'll find a couple of new Special
Editions. The most recent (as I write) is from the virtualization series that we did a little
while ago, with more Special Editions from Robin in the pipeline. FCM#58 is now available
as an EPUB, while Jens is playing catch-up with back issues. I also want to thank all of you
who've subscribed to the FCM issues on Google Currents. We need over 200 subscribers per
issue to appear in the Google Currents search results, and FCM#58 has over 400
subscribers. You folks are awesome!

All the best, and keep in touch!
Ronnie

ronnie@fullcirclemagazine.org

This magazine was created using :

Full Circle Podcast
Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:
Robin Catling
Ed Hewitt
Dave Wilkins

http://fullcirclemagazine.org

mailto:ronnie@fullcirclemagazine.org
http://www.scribus.net
http://www.gimp.org
http://www.libreoffice.org
http://creativecommons.org/
http://fullcirclemagazine.org
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FC Notifier Update

The Full Circle Notifier is still at
1.0.2, but the PPA has been
updated for Oneiric. FCN is a
small application that sits in your
system tray and will announce
issue/podcast releases, and can
be set to download them too! For
more info, see the FCN Google
Group: http://goo.gl/4Ob4

EPUB

Finally, we have mobile editions
of Full Circle on the downloads
page. At the moment there are
only a couple of issues online,
but we're hoping to have back
issues online shortly. If you've
any problems with the epub
file/formatting, you can drop an
email to Jens at:
mobile@fullcirclemagazine.org

Big thanks to Jens, Oppih and
the beta testers for making
them a reality.

Finnish game developer
Frozenbyte is pleased to
announce that Trine 2 will
be released for the Linux

platform on April 2, 2012. Trine 2
will be available via the Humble
Store widget on the official
website http://www.trine2.com/.

The ”Humble Store” is a new
type of widget where customers
can buy the game direct from the
developer. Currently the store sells
the Linux copy as well as keys for
Steam. Other Non-DRM versions
will be added next year to all
buyers.

”We see Linux as a very
potential platform and are glad to
see more developers embracing it.
New campaigns like the Humble
Bundles have really paved way for
the Linux gaming community and
we see it as a growing market that
we really want to be part of. And
what a community it is, these guys
will gladly pay even extra for their
game and also help you fix it.” said
Mikael Haveri, the Marketing
Manager of Frozenbyte.

Jukka Kokkonen, the lead Linux
coder had this to say about the
process:

“Linux porting of Trine 2 turned
out to be mostly easier than
expected as the game had already
a working Mac OS X version, which
also used an OpenGL renderer. The
initial OpenGL rendering port took
less than two days, after which the
renderer was mostly functional,
with only bugs to iron out."

The original Trine was released
in 2009 and has since sold 1.1
million copies. Largest contributors
to the unit numbers have been
Steam and the Humble Bundle,

with PlayStation Network and Mac
App Store also generating major
sales. In addition, supporting
growing platforms like OnLive and
Linux have played notable part in
keeping Trine 1 viable and a well-
selling title to the day.

Trine 2 for Linux will be
available through
http://www.trine2.com/buy/. The
regular edition is priced at
$14.99/12.99 euros/11.99 pounds.
The Collector's Edition is available
for $24.99/19.99 euros/17.99
pounds. The Collector's Edition
includes a digital artbook and the
original soundtrack by the
acclaimed composer Ari Pulkkinen.

http://goo.gl/4Ob4
mailto:mobile@fullcirclemagazine.org
http://www.trine2.com/
http://www.trine2.com/buy/
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Two months ago I wrote
about using SSH and
Rsync. This month, I'd like
to introduce you all to a

trick I've recently started using for
wirelessly syncing my android
tablet, as well as outline a few
other useful tricks I use, which
others might find useful.
Specifically, how to display a
custom date in a foreign language
(in Conky), how to spruce up your
Vim interface (and PS1 prompt),
and a script to randomly select an
image for your background every
15 minutes. I realize that GNOME
can probably take care of your
backgrounds for you, but someone
may still find a use for it. For
anyone who wants an idea of the
date and PS1 adjustments, check
out this month's screenshot on my
deviantart page
(http://lswest.deviantart.com/#/d4
se2tv)

Android

The things you'll need for this
are as follows:

On the Android device:
QuickSSHd (as far as I

remember, it's free). Once it's
installed, simply check the IP
address of the device, and give it a
password/port. To start the server,
hit the button that says “off” (so
that it reads “on”).

On your PC:
sshfs, and a mount-point

(preferably in your home folder)
for the device.

A brief explanation of the
process:

I simply mount the sdcard folder
using sshfs, and then copy files
over as I would using USB (which
never worked very well for me and
my Asus TF101 Transformer
eeePad for media files). As for how
to do this, see below.

Mounting can be done with:

sshfs root@127.0.0.1:/sdcard/

~/tf101 ­p 2222

Just like with rsync, you need to
specify the path after a colon, and

to avoid input/output errors on the
mounted folder, you must have a
closing slash at the end of the path.
The second path is the mountpoint,
and the -p 2222 is simply the port
that QuickSSHd is listening on.

After this, copy the files to the
folder with whichever method you
prefer.

As an optional final step, I find
that my Music app does not refresh
after these files are added. The
only way I've found to fix this is to
go to the File Manager, and rename
the copied file/folder, forcing the
tablet to re-load the information.

Custom date

I've been learning Japanese for
a while now, and decided to display
the date in Japanese (both for
practice, and to save space).
However, it was not so easily done,
as I use Conky for my status bar in
XMonad. My solution to this is to
write the following code-segment,
which I call every few seconds from
my conkyrc. You may need to run
the following command to get the

right formatting (this applies to
any locale you may decide to use).

locale­gen ja_JP.UTF­8

Code-segment:

#!/bin/sh

LC_ALL="" LC_TIME=ja_JP.UTF­8

date +'%A, %­d %B%Y %H:%M'

You'll of course need to change
the date format into the string
you'd like (thoroughly documented
in the man page).

Vim & PS1 (Powerline)
Powerline homepage:
https://github.com/Lokaltog/vim-
powerline

The easiest way to install
Powerline is to use vundle.
Instructions for installing Vundle
are on the github page, here:
http://github.com/gmarik/vundle.
Once you've installed it, you'll need
to add the following three lines to
your .vimrc:

set

rtp+=~/.vim/bundle/vundle/

CCOOMMMMAANNDD && CCOONNQQUUEERR
Written by Lucas Westermann TTrriivviiaalliibbrree

https://github.com/Lokaltog/vim-powerline
http://lswest.deviantart.com/#/d4se2tv
http://github.com/gmarik/vundle
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Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

COMMAND & CONQUER

call vundle#rc()

Bundle 'Lokaltog/vim­

powerline'

After which you'll need to open
vim and type :InstallBundle
(requires git to install)

Once you've installed it, you'll
need to patch the font you're using
with the script found under the
folder fontpatcher (full path will be
something like ~/.vim/bundle/vim-
powerline/fontpatcher). The
readme file there will guide you
through the patching.

Once your font is patched (and
your font-cache reloaded with the
command fc-cache), you can add
the final line to your .vimrc to get
arrow shapes.

let

g:Powerline_symbols='fancy'

If you find this to be something
you want for your prompt as well,
you simply need to make sure
you're using the patched font, and
copy the arrow from the vim line
into your .bashrc prompt line,
which I sadly can't supply, as it
would require a patched font.
Make sure you set the background

behind the arrow glyph to the next
color, and the foreground to the
previous, to achieve the arrow
appearance.

Wallpaper

This script, as I have it written,
requires fluxbox to be installed (for
the fbsetbg program). However, if
you know of a command-line
wallpaper setter that offers a
random option, feel free to replace
it.

The script:

#!/bin/bash

while true

do

fbsetbg ­R

~/Pictures/Hyperion/Wallpaper

s/Guitars

sleep 15m

done

The script runs in an infinite
loop, calling the random command
on my guitar wallpaper folder
every 15 minutes. If anyone has
any adjustments (or improvements
upon the script), feel free to send
me an email about it!

Hopefully some of you will find
some of these tips useful (and
hopefully I've interested one or
two readers into using Vim a bit
more). If anyone has any questions,
comments, or suggestions, I can be
reached at lswest34@gmail.com.
Any emails should include “C&C” or
“FCM” in the subject line, so that I
don't overlook it. Happy
customizing!

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org

mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
http://podcast.ubuntu-uk.org/
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HHOOWW--TTOO
Written by Greg D. Walters BBeeggiinnnniinngg PPyytthhoonn -- PPaarrtt 3311

After our last meeting you
should have a fairly good
idea of how to use Page.
If not, please read last

month's article. We'll continue this
time by creating a file list
application with a GUI. The goal
here is to create a GUI application
that will recursively walk through a
directory, looking for files with a
defined set of extensions, and
display the output in a treeview.
For this example we will look for
media files with the extensions of
“.avi”, “.mkv”, “.mv4”, “.mp3” and
“.ogg”.

This time, the text might seem a
bit terse in the design portion. All
I'm going to do is give you
directions for placement of
widgets and the required
attributes and values like this...

Widget

Attribute: Value

I will only quote text string
when it is needed. For example for
one of the buttons, the text should
be set to “...”.

Here's what the GUI of our
application will look like...

As you can see, we have our
main form, an exit button, a text
entry box with a button that will
call up an ask for directory dialog
box, 5 check boxes for extension
selecting extension types, a “GO!”
button to actually start the
processing and a treeview to
display our output.

So, let's get started. Fire up
Page and create a new top level
widget. Using the Attribute Editor
set the following attributes.

Alias: Searcher

Title: Searcher

Be sure to save often. When you
save the file, save it as “Searcher”.
Remember, Page puts the .tcl
extension for you and when you
finally generate the python code, it
will be saved in the same folder.

Next add a frame. It should go
at the very top of the main frame.
Set the attributes as follows.

Width: 595

Height: 55

x position: 0

y position: 0

In this frame, add a button. This
will be our Exit button.

Alias: btnExit

Text: Exit

Move this close to the center of
the frame or close to the frame's
right side. I set mine to X 530 and Y
10.

Create another frame.

Width: 325

Height: 185

y position: 60

Here is what this frame will look

like, to give you a guide going
forward through this section.

In this frame, add a label. Set
the text attribute to “Path:”. Move
it close to the top left of the frame.

In the same frame, add an entry
widget.

Alias: txtPath

Text: FilePath

Width: 266

Height: 21

Add a button to the right of the
entry widget.

Alias: btnSearchPath

Text: “...” (no quotes)

Add five (5) check buttons. Put
them in the following order...
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HOWTO - BEGINNING PYTHON 31
x

x x

x x

The three check buttons on the
left are for video files and the two
on the right are for audio files. We
will deal with the three on the left
first, then the two on the right.

Alias: chkAVI

Text: “.avi” (no quotes)

Variable: VchkAVI

Alias: chkMKV

Text: “.mkv” (no quotes)

Variable: VchkMKV

Alias: chkMV4

Text: “.mv4” (no quotes)

Variable: VchkMV4

Alias: chkMP3

Text: “.mp3” (no quotes)

Variable: VchkMP3

Alias: chkOGG

Text: “.ogg” (no quotes)

Variable: VchkOGG

Finally, in this frame add a
button somewhere below the five
check boxes and somewhat
centered within the frame.

Alias: btnGo

Text: GO!

Now add one more frame below
our last frame.

Width: 565

Height: 265

I placed mine around X 0 Y 250.
You might have to resize your main
form to have the entire frame
show. Within this frame, add a
Scrolledtreeview widget.

Width: 550

Height: 254

X Position: 10

Y Position: 10

There. We've designed our GUI.
Now all that is left to do is create
our function list and bind the
functions to our buttons.

In the Function list window, click
the New button (the far left
button). This brings up the new
function editor. Change the text in
the Function entry box from “py:
xxx” to “py:btnExitClick()”. In the
arguments entry box type “p1”. In
the bottom multiline entry box,
change the text to:

def btnExitClick(p1):

sys.exit()

Notice that this is not indented.
Page will do that for us when it
creates the python file.

Next create another function
called btnGoClick. Remember to
add a passed parameter of “p1”.
Leave the “pass” statement. We'll
change that later.

Finally, add another function
called “btnSearchPath”. Again,
leave the pass statement.

Lastly, we need to bind the
buttons to the functions we just
created.

Right-click on the exit button
we created, select Bind. A large
box will pop up. Click on the New
binding button, Click on Button-1
and change the word “TODO” in
the right text entry box to
“btnExitClick”. Do NOT include the
parens () here.

Bind the GO button to
btnGoClick and the “...” button to
btnSearchPathClick.

Save your GUI and generate the
python code.

Now all we have left is to create
the code that “glues” the GUI
together.

Open up the code we just

generated in your favorite editor.
Let's start off by examining what
Page created for us.

At the top of the file is our
standard python header and a
single import statement to import
the sys library. Next is some rather
confusing (at first glance) code.
This basically looks at the version
of python you are trying to run the
application in and then to import
the correct versions of the tkinter
libraries. Unless you are using
python 3.x, you can basically ignore
the last two.

We'll be modifying the 2.x code
portion to import other tkinter
modules in a few moments.

Next is the “vp_start_gui()”
routine. This is the program's main
routine. This sets up our gui, sets
the variables we need, and then
calls the tkinter main loop. You
might notice the line “w = None”
below this. It is not indented and it
isn't supposed to be.

Next are two routines
(create_Searcher and
destroy_Searcher) that are used to
replace the main loop routine if we
are calling this application as a
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library. We don't need to worry
about these.

Next is the “set_Tk_var”
routine. We define the tkinter
variables used that need to be set
up before we create the widgets.
You might recognize these as the
text variable for the FilePath entry
widget and the variables for our
check boxes. The next three
routines here are the functions we
created using the function editor
and an “init()” function.

Run the program now. Notice
that the check buttons have grayed
out checks in them. We don't want
that in our “release” app, so we'll
create some code to clear them
before the form is displayed to the
user. The only functioning thing
other than the check boxes is the
Exit button.

Go ahead and end the program.

Now, we'll take a look at the
class that actually holds the GUI
definition. That would be “class
Searcher”. Here is where all the
widgets are defined and placed in
our form. You should be familiar
with this by now.

Two more classes are created
for us that hold the code to
support the scrolled tree view. We
don't have to change any of this. It
was all created by Page for us.

Now let's go back to the top of
the code and start modifying.

We need to import a few more
library modules, so under the
“import sys” statement, add...

import os

from os.path import join,

getsize, exists

Now find the section that has
the line “py2 = True”. As we said
before, this is the section that
deals with the tkinter imports for
Python version 2.x. Below the
“import ttk”, we need to add the
following to support the FileDialog
library. We also need to import the
tkFont module.

import tkFileDialog

import tkFont

Next we need to add some
variables to the “set_Tk_var()”
routine. At the bottom of the
routine, add the following lines...

global exts, FileList

exts = []

FileList=[]

Here we create two global
variables (exts and FileList) that
will be accessed later on in our
code. Both are lists. “exts” is a list
of the extensions that the user
selects from the GUI. “FileList"
holds a list of lists of the matching
files found when we do our search.
We'll use that to populate the
treeview widget.

Since our “btnExitClick” is
already done for us by Page, we'll
deal with the “btnGoClick” routine.
Comment out the pass statement
and add the code so it looks like
this...

def btnGoClick(p1) :

#pass

BuildExts()

fp = FilePath.get()

e1 = tuple(exts)

Walkit(fp,e1)

LoadDataGrid()

This is the routine that will be
called when the user clicks the
“GO!” button. We call a routine
called “BuildExts” which creates
the list of the extensions that the
user has selected. Then we get the
path that the user has selected
from the AskDirectory dialog and
assign that to the fp variable. We
then create a tuple from the
extension list, which is needed
when we check for files. We then
call a routine called “Walkit”,
passing the target directory and
the extension tuple.

Finally we call a routine called
“LoadDataGrid”.

Next we need to flesh out the
“btnSearchPathClick” routine.
Comment out the pass statement
and change the code to look like
this...

def btnSearchPathClick(p1) :

#pass

path =

tkFileDialog.askdirectory()

#**self.file_opt)

FilePath.set(path)

HOWTO - BEGINNING PYTHON 31
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The init routine is next. Again,
make the code look like this...

def init():

#pass

# Fires AFTER Widgets

and Window are created...

global treeview

BlankChecks()

treeview =

w.Scrolledtreeview1

SetupTreeview()

Here we create a global called
“treeview”. We then call a routine
that will clear the gray checks from
the check boxes, assign the
“treeview” variable to point to the
Scrolled treeview in our form and
call “SetupTreeview” to set the
headers for the columns.

Here's the code for the
BlankChecks routine which needs
to be next.

def BlankChecks():

VchkAVI.set('0')

VchkMKV.set('0')

VchkMP3.set('0')

VchkMV4.set('0')

VchkOGG.set('0')

Here, all we are doing is setting
the variables (which automatically
sets the check state in our check
boxes) to “0”. If you remember,
whenever the check box is clicked,
this variable is automatically
updated. If the variable is changed
by our code, the check box
responds as well. Now (above right)
we'll deal with the routine that
builds the list of extensions from
what the user has clicked.

Cast your memory
back to my ninth article in
FCM#35. We wrote some
code to create a catalog
of MP3 files. We'll use a
shortened version of that
routine (middle right).
Refer back to FCM#35 if
you have questions about
this routine.

Next (bottom right) we
call the SetupTreeview
routine. It's fairly
straightforward. We define a
variable “ColHeads” with the
headings we want in each
column of the treeview. We

do this as a list. We then set the
heading attribute for each column.
We also set the column width to
the size of this header.

Finally we have to create the
“LoadDataGrid” routine (next
page, top right) which is where we
load our data into the treeview.
Each row of the treeview is one
entry in the FileList list variable.
We also adjust the width of each
column (again) to match the size of
the column data.

That's it for the first blush of

the application. Give it a run and
see how we did. Notice that if you
have a large number of files to go
through, the program looks like it's
not responding. This is something

HOWTO - BEGINNING PYTHON 31

def BuildExts():

if VchkAVI.get() == '1':

exts.append(".avi")

if VchkMKV.get() == '1':

exts.append(".mkv")

if VchkMP3.get() == '1':

exts.append(".mp3")

if VchkMV4.get() == '1':

exts.append(".mv4")

if VchkOGG.get() == '1':

exts.append(".ogg")

def Walkit(musicpath,extensions):

rcntr = 0

fl = []

for root, dirs, files in os.walk(musicpath):

rcntr += 1 # This is the number of folders we have walked

for file in [f for f in files if f.endswith(extensions)]:

fl.append(file)

fl.append(root)

FileList.append(fl)

fl=[]

def SetupTreeview():

global ColHeads

ColHeads = ['Filename','Path']

treeview.configure(columns=ColHeads,show="headings")

for col in ColHeads:

treeview.heading(col, text = col.title(),

command = lambda c = col: sortby(treeview, c, 0))

## adjust the column's width to the header string

treeview.column(col, width =

tkFont.Font().measure(col.title()))
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that needs to be fixed. We'll create
routines to change our cursor from
the default to a “watch” style
cursor and back so when we do
something that takes a long time,
the user will notice.

In the “set_Tk_var” routine, add
the following code at the bottom.

global

busyCursor,preBusyCursors,bus

yWidgets

busyCursor = 'watch'

preBusyCursors = None

busyWidgets = (root, )

What we do here is set up
global variables, assign them and
then we set the widget(s) (in
busyWidgets) we wish to respond
to the cursor change. In this case
we set it to root which is our full
window. Notice that this is a tuple.

Next we create two routines to
set and unset the cursor. First the
set routine, which we will call
“busyStart”. After our
“LoadDataGrid” routine, insert the
code shown middle right.

We first check to see if a value
was passed to “newcursor”. If not,
we default to the busyCursor. Then

we walk through the
busyWidgets tuple
and set the cursor to
whatever we want.

Now put the code
shown bottom right
below it.

In this routine, we
basically reset the
cursor for the widgets
in our busyWidget
tuple back to our
default cursor.

Save and run your
program. You should
find that the cursor
changes
whenever you
have a long list of
files to go
through.

While this
application
doesn't really do
much but show
you how to use
Page to create
really fast code development. From
today's article, you can see how
having a good design of your GUI
ahead of time can make the
development process easy and

fairly painless.

The tcl file is saved in pastebin
at http://pastebin.com/AA1kE4Dy
and the python code is saved at

http://pastebin.com/VZm5un3e.

See you next time.

def LoadDataGrid():

global ColHeads

for c in FileList:

treeview.insert('','end',values=c)

# adjust column's width if necessary to fit each value

for ix, val in enumerate(c):

col_w = tkFont.Font().measure(val)

if treeview.column(ColHeads[ix],width=None)<col_w:

treeview.column(ColHeads[ix], width=col_w)

def busyStart(newcursor=None):

global preBusyCursors

if not newcursor:

newcursor = busyCursor

newPreBusyCursors = {}

for component in busyWidgets:

newPreBusyCursors[component] = component['cursor']

component.configure(cursor=newcursor)

component.update_idletasks()

preBusyCursors = (newPreBusyCursors, preBusyCursors)

def busyEnd():

global preBusyCursors

if not preBusyCursors:

return

oldPreBusyCursors = preBusyCursors[0]

preBusyCursors = preBusyCursors[1]

for component in busyWidgets:

try:

component.configure(cursor=oldPreBusyCursors[component])

except KeyError:

pass

component.update_idletasks()

http://pastebin.com/AA1kE4Dy
http://pastebin.com/VZm5un3e
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S
o far, we have covered
many topics for using
LibreOffice's Calc, but Calc
has many minor operations

that are worth knowing. In this
article, I will give you my top-10
quick tips for using Calc. Most of
them have to do with manipulating
the current sheet. You can use
these tips in most any sheet you
are working with.

1. Naming Sheets

The default name for sheets is
SheetX, where X is a number. You
have 3 ways to name a sheet. The
first is when you create a new
sheet, using Insert > Sheet. In the
dialog, you have a choice of how
you want to name the sheet. You
can also choose to insert multiple

sheets. When inserting multiple
sheets, you have no control over
the sheets' names. They will get
the default SheetX naming
convention.

However, you may need to
rename a sheet after it has been
created. This is where the second
and third methods apply. The
second way to name a sheet is by
right-clicking the sheet's tab and
selecting Rename Sheet from the
menu. The Rename Sheet dialog
will come up, and you can change
the name of the sheet. The third
method is simply to double-click
the sheets tab. This brings up the
rename Sheet dialog, where you
can change the sheet's name.

NOTE: The sheet name must start
with a letter or digit. Then, sheet
names can include spaces, letters,
digits, underscore, and some
special characters, i.e. -, &. When
saving in the Microsoft Excel
format, sheet names cannot
contain the :, \, /, ?, *, [, and ]
characters. If you have an invalid
character in the name, Calc will
give you an error message.

2. Deleting Sheets

Sometimes, you will want to
delete a sheet, or multiple sheets,
from the workbook. To delete a
sheet, right-click on the sheet's tab
and select Delete from the menu,
or select Edit > Sheet > Delete
from the menu bar. Calc will verify
that you do want to delete the
sheet. To delete multiple sheets
hold down the Ctrl key while
clicking on the tabs for the sheets
you want to delete. Use either the
right-click or the menu method to
delete the sheets. Once again, Calc
will verify that you want to delete
the sheets.

3. Move/Copy Sheets

Sometimes, you need to
rearrange or copy sheets. For
example, you might want to order
a multiple sheet workbook in order
of predominate use, or by date.
Copying a sheet comes in handy
when you need to create an exact
duplicate of the current sheet,
thereby creating a history. When
you copy a sheet, you get an exact
duplicate of the sheet you copied;
however when you make changes
to the new sheet, those changes
are not translated to the old sheet.
For example, you can create a copy
of a budget spreadsheet for each
pay period of the year and keep
them all in one workbook.

Moving sheets is accomplished
in one of two ways. The first
method is to drag the tab of the
sheet to the position you want it.
Double arrows will show the
location the sheet will occupy
when you release it. The other
method is through the Move/Copy
Sheet dialog. You can access the
Move/Copy dialog by right-clicking
the tab you want to copy or move
and selecting Move/Copy Sheet, or
through the menu bar, Edit > Sheet
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> Move/Copy Sheet. Under the
Action section, you can select to
copy or move the current sheet.
NOTE: If you have only one sheet in
the workbook, move and copy are
grayed out, and copy is selected. In
the Location section, you can select
to move/copy the sheet to the
current document, to another open
document, or to a new document.
The Insert Before section controls
the placement of the move/copy.
The sheet will move/copy to a
position before the selected sheet.
A special choice here is the “- move
to end position -”. Selecting this
last choice will move/copy the
sheet to the end of the sheet list.
The Name section allows you to
give the sheet a new name.
Renaming your sheet is a good idea
when copying. If you do not give it
a new name, it will keep the
existing name and append an
underscore and a number, i.e.
MySheet_2.

4. Color Tabs

Visual aids can often help get
things done quickly while working
with a large workbook with
multiple sheets. Color is an easy to
deploy visual aid. Giving each sheet
tab a different color can help you
find it and go to it quickly. The tab
of the current sheet is always
white, but you can still give it a
color for when it is not selected. To
set the tab color of a sheet, right-
click the tab and select Tab Color
from the menu. A color dialog will
pop up. Simple select the color you
want for the tab and click OK.

5. Freeze
Row(s)/Column(s)

Long and wide sheets often
require scrolling to view some of
the content in the sheet. However,
in many cases the first columns or
rows contain information you need
in order to make sense of the
information. Luckily, Calc provides
you with a way to freeze rows and
columns in place.

To freeze a row or rows, select
the row below the row(s) you want
frozen by clicking on the row
number, then Window > Freeze. To
unfreeze the rows, select Window
> Freeze again. The same is done
with the columns by selecting the
column letter to the right of the
columns you want frozen, then
Window > Freeze.

To freeze both rows and
columns, select the cell below the
rows you want frozen and to the
right of the columns you want
frozen, then select Window >
Freeze.

6. Split Screen

Another way to view large
sheets is using the split screen. To
split the screen horizontally, grab
the thick bar just above the vertical
scrollbar. The mouse cursor will

become a double arrow. Drag the
thick bar down to the position
where you want it. To split the
screen vertically, do the same with
the thick bar to the right of the
horizontal scrollbar. To get a quick
horizontal and vertical split, just
select Window > Split. The spits are
shown by a thick heavy line. Each
area of the split screen is
manipulated by the various new
scrollbars that appear.

To undo a split screen, grab the
thick heavy line and drag it up to
the top for a horizontal split or to
the right for a vertical split. To
cancel all spits, use Window > Split.
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Elmer Perry's history of working, and
programming, computers involves an
Apple IIE, adding some Amiga, a
generous helping of DOS and
Windows, a dash of Unix, and blend
well with Linux and Ubuntu.

7. Print Rows or
Columns on Every Page

Printing a sheet which will span
multiple pages may require key
information in certain rows or
columns in order to help make
sense of the data. To control how
the pages print, you can define
whether certain rows or columns
repeat on each page.

Open format > Print Ranges >
Edit. Under Rows to repeat, you
can define the rows that need to
repeat on each page, i.e. to repeat
the first two rows enter $1:$2.
Under Columns to repeat, you can
do the same for the columns, i.e. to
repeat the first column type $A.

8. Fill Selected Cells

At its most basic use, the fill
tool is a way to repeat information
in a cell. To repeat the information
in a cell, select the cells you want
to repeat, then Edit > Fill > (the
direction you want to fill: left,

right, up, or down).

However, the real power of the
fill tool come through using the Fill
Series. Edit > Fill > Series. The Fill
Series tool allows you to create
many different types of serial
information, from numbers to
dates. There is also AutoFill, which
uses a series of text predefined in
the program. Examples of the
AutoFill are Days of the week and
months. You can define your own
AutoFill ranges in Tools > Options >
LibreOffice Calc > Short Lists.

9. Selection List

The selection list is
a text function. The
selection list works
only for text, and will
contain only text
from the current
column your selected
cell is in. To activate

the list, select an empty cell and
press Alt + Down Arrow on your
keyboard.

10. Remove Data from
Cells

Sometime, you need to not just
change the data in a cell but
completely remove it. Removing
data can be done in one fell swoop,
and you can select the type of
information that is removed. For
example, you can select a group of
cells and choose to remove only
the formating, or only the text.
There is also a remove all to
remove all the information from
the cell(s). You activate the
Remove Content dialog by
selecting a cell or cells and
pressing the Backspace key on the

keyboard. You can also do this
through the menus: Edit > Delete
Content.

So, there you have it; my top-10
quick tips for LibreOffice Calc.

In my next article, we will
continue our journey in Calc by
learning how to create charts and
graphs.

HOWTO - LIBREOFFICE PART 13
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Written by Petescan321 PPoorrttaabbllee LLiinnuuxx

S
urely you use Linux on your
PC, why else read a Linux
magazine like this one.
Although we love our own

machines and have tweaked them
to our liking, sometimes we have to
-inevitably- use another computer.
Either at the office or at a friend’s
house, we have to use what they
have... something non-Linux. But
wait, what if you could carry your
own Linux distro with you! I don't
mean a live CD. How about a USB!
Well this article will tell you how to
solve this problem.

There are two ways to create a
Linux distro on a USB flash drive.
Before we start, make sure you
have at least a 4GB USB stick. Let's
start with the easy way, for
Debian/Ubuntu based distros only:

Download and install Gparted.
Run Gparted and select your USB.

Right-click the partition and
select “format to” then click on
Fat32, and Apply, then wait until it
finishes. (You may have to unmount
it, to do this right-click the partition
and select unmount.)

Run Startup disk creator. (It
usually comes pre-installed with
Linux.)

Select your ISO and set your
Reserved space to maximum.
(Reserved space means you will be
able to save files to your USB Stick.
On a 4GB USB it will give you 2GB
of Reserved space. On an 8GB USB
it will give you 4GB of Reserved
space).

Click on Make Startup Disk, and
go fetch yourself some coffee, it
may take as long as 30 minutes to

complete the process.

If you want to be more technical
about your USB follow these steps.
This is the hard way (Most distros
will work, including RedHat/Fedora
based distros).

Download and install Gparted.

Run Gparted and select your
USB. (Make sure your USB is
formatted Fat32).

Left click the partition, and
select Resize/Move (You may have
to unmount it, to do this right-click
the partition and select unmount).

Select how much space you
want for saving files. Make sure the
distro at least has 4GB for your
Linux OS.

Left click on
the Unallocated
Partition, and on
the new partition
button.
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Select the formatting to ntfs,
then click add. (If you want, you can
rename your partition).

Click apply, and wait until it
finishes. Then remove your USB,
then reinsert the USB.

Run UNetbootin, and select
your ISO or choose one from the
list of Linux distros.

Click OK to proceed.

If you don't have Unetbootin,
you can download it from
http://unetbootin.sourceforge.net/
#install.

What now? Well, now you can
show off your USB at the office, at
school, or at your friend’s house.
You can also then customize your
Linux distro of your choice from
your USB... making your USB your
PC.

Here is a list of my favorite USB

Linux distros:

Kiwi10.08

PuppyLinux

VectorLinux

BodhiLinux

DSL

Petescan321 is a freelance software
technician, who enjoys fixing
computers running Windows or
Debian-based Linux. He is also a Linux
and open-source supporter.

http://unetbootin.sourceforge.net/#install
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Written by Robin Catling AAddjjuusstt VViirrttuuaall DDiisskk SSiizzee IInn VVBBooxxMMaannaaggee

It's a common problem: you run
VirtualBox, create a virtual
machine, probably with a
dynamic disk, at your best

guess at an adequate disk size, run
it for a while, then find you're
running out of space.

You can easily expand the hard
disk size in VirtualBox using the
command:

VBoxManage modifyhd ­­resize

The --resize option allows you to
change the capacity of an existing
image; this adjusts the logical size
of a virtual disk without affecting
the physical size. It works only for
expanding the capacity of VDI and
VHD virtual disk formats, and only
dynamically allocated, not fixed
size disks. But this is a way to add
more space to a virtual disk
without needing to create a new
image, attach and copy all the data
across within a virtual machine.

This is a command-line
application, so you need to open a
Terminal session in order to run the
command, and change directory to

the path where your virtual disk is
stored.

Two important notes:
• Shutdown the running virtual
machine before you mess with the
disk!
• Backup the existing disk image, or
at least any volatile data, before
you alter it!

The command you need follows
this pattern:

VBoxManage modifyhd

XP_newdisk.vdi ­­resize 10240

• VBoxManage is the utility suite
that comes with VirtualBox:
• modifyhd is the command to
resize the virtualdisk
• XP_new.vdi is my example disk
name; you'll need to change it to
match your disk name, and don't
forget the .vdi suffix. Under Linux
it's also case sensitive.
• --resize 10240 Next is the desired
new size for the virtual disk. That's
two dashes before the word
"resize" followed by a number in
megabytes; 10240 being
equivalent to 10GB.

Also remember that you'll need to
increase the size of your guest
partition on the disk, or create an
additional partition in the new
space. In this respect, you'll need
to do the work with disk utilities
appropriate to your guest
operating system just as if it were a
real PC with real spinning rust
(magnetic disks).

Note:.vmdk disks cannot be
expanded by modifyhd commands.
Try this command line and you'll
get the error: VBoxManage: error:
Resize harddiskoperation forthis

format is not implementedyet!

You can find the manual for
Oracle VirtualBox, indexed by each
topic, on the website. VBoxManage
is in Chapter 8:
http://www.virtualbox.org/manual/
ch08.html#vboxmanage-modifyvdi
where the full syntax of the
command looks like this:
VBoxManage modifyhd

<uuid>|<filename>

[­­type

normal|writethrough|immutable

|shareable|

readonly|multiattach]

[­­autoreset on|off]

[­­compact]

[­­resize <megabytes>|­­

resizebyte <bytes>]

The --compact option can be
used to shrink disk images, that is,
remove blocks of empty space
(containing zeroes). This will shrink
a dynamically allocated image by
reducing the physical size of the
image without affecting the logical
size of the virtual disk.

However, free space in the
guest system must first be zeroed.
For Windows guests, you can use
the sdelete tool provided by
Microsoft; running sdelete -c in the
guest will zero the free disk space.
Under Linux, the zerofree utility
supports ext2/ext3 filesystems to
do the same. You can then compact
(compress) the virtual disk image.

Note: instructions and links relate
to the Oracle VirtualBox version
and not to the VirtualBox OSE
package contained in the official
Ubuntu repositories.

http://www.virtualbox.org/manual/ch08.html#vboxmanage-modifyvdi
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Written by Peter Glaser CCrreeaattee GGrreeeettiinngg CCaarrddss IInn LLiibbrreeOOffffiiccee DDrraaww

The template files for this tutorial
can be downloaded from:
http://goo.gl/6mhQ7
http://goo.gl/uehRw

S
everal years ago, I created
two templates for creating
cards and posted them on
the Open Office website.

While they weren't perfect, they
could be used to make a relatively
nice looking birthday or general
purpose card. The main portion of
the card was made in Microsoft
Paint, then moved over to Open
Office Writer. Recently, I decided
to revisit the greeting card, and
attempted to make an entirely new
card in LibreOffice Draw. The
results are a better, more usable
card.

Using the Card

Load the card by double clicking
on it. The card will load LibreOffice
Draw. Go to the front page section
(lower right side), and place the
cursor at either the top or bottom
of the text. Then drag across the
text. (If you prefer, you can triple-

click on any word in this section to
highlight all the text.) Type in your
message, then
format the
words. There
are a number of
ways to format
the words. Start
by highlighting
the text. I
suggest that
you use either
the Format
Menu, then
select
Character,
Fonts.... or just
right click on
the highlighted
text box, then
select Character,
Fonts. Pick a Font, a Style, and a
Size. Clicking on the Font Effects
tab, then Automatic, will allow you
to change the color of the text. The
checkoff boxes below allow you to
add outlines and shadows. Be sure
to click OK to apply the changes.

Changing the color of the box is
relatively easy. Be sure that you
have your Drawing toolbox open.

Under View, Toolbars, make sure
that Drawing is check-marked. It

should be the
default when
you load the
template. Next,
you must look
for the tab
marked Layer 4.
There are several
tabs located
along the
bottom of the
template. Layer
4 is hidden, but
is next to Layout,
Controls,
Dimension Lines,
Layer 5. Use the
arrow to the left

of the word
Layout to move the tabs to the
right. Then click on Layer 4. After
clicking on Layer 4, select the blue
rectangle from the drawing tools.
Move to the front section of the
card and start at the bottom right
corner. Drag the mouse across the
entire Front section. Right click and
select the word, Area. In this
section choose the color that you
would like for the Front of the card.

Click OK to apply the color. (Select
white for your area color if you
have a black-and-white laser
printer.) Lines are made in a similar
manner. Right click on the Front
box. Choose Line. Then pick the
Color, Style, and Width of the lines.
Keep the line width to .06 or less
for best results. Click OK upon
making your selections. After
adding color to the text area and
lines for the Front section, you will
notice that your text has
disappeared. It is actually in the
layer below. The easy fix is to right-
click on the highlighted Front
section, then select Arrange. Send
Backward will move your text
above the color and lines. Click OK
to set this section.

Completing the Inside of the
Card is done in a similar manner.
There are a couple of things to
keep in mind, however. Triple-
clicking will not highlight the text
area. Click on the area around the
words in the inside text box. You
will have to start at the very top or
very bottom of the text, then drag
across to highlight the text. Type
your message over the highlighted

http://goo.gl/6mhQ7
http://goo.gl/uehRw
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text. Format the text using Format,
Character as you did before. Also,
after you format the text, you will
have to rotate the text in both
sections of the Inside of the Card.
To do this, highlight the text box by
clicking on it once. Make sure that
you are on the outside of the text
box and not on the text itself. This
is the area right around the text. A
little box will surround your text.
Right click, then select Position and
Size. Go down to Angle and type
the number 180 for the number of
degrees. That will flip the text box
vertically. When printed out, the
text boxes on the inside will appear
in the correct position. Always click
OK to apply the changes.

To complete the card, just
highlight the created-by section in
the lower left hand corner of the
card. Click to the right of the
words, Created by. Next enter your
name. At this point you should save
your card. The card is very basic at
this point. It contains only text
boxes and some colored
backgrounds and lines. You can add
symbols from the Drawing tools
section like stars and symbol
shapes if you desire. If you are
using a black-and-white printer, you
may want to print off your card.
After you print the card, fold the

card in half horizontally, then
vertically, to complete your card.

ClipArt

If you would like to spice up
your card even more, you can add
clip art from the Internet. I have
found that the easiest way to add
clipart to the cards is first create a
separate page in LibreOffice
Writer. On that
page you can
paste your
clipart. That
gives you a
place to store
clipart for later
use.

First, Open
LibreOffice
Writer. Keep it
open. Then
open your web
browser and do
a search for free
web art. I
located a site
called All Free
Clipart at: http://www.allfree-
clipart.com/. There are a number of
websites that allow an individual to
download free artwork and use it
free-of-charge. Select a piece of

artwork, then right-click and copy
the image. Then click on the
LibreOffice Writer tab in the
taskbar (bottom of the screen).
That will bring LibreOffice Writer
up in front of your browser. Paste
the selected artwork onto the
Writer page. I like to give the
Writer page a name right away, so
that it is easily identified after
saving it. Notice the Writer tab at

the bottom will be
renamed. Click
on the browser
tab in the
taskbar. That will
bring your
browser back to
the Internet
artwork. Make
another
selection and
paste it onto
your Writer
artwork page.
Continue doing
this until you
have built up a
small artwork

collection. I
choose clipart that can be used for
birthdays, holidays, and other
special occasions. Be sure to save
your art collection.

Using the clipart is simple. Close

the browser and launch LibreOffice
Draw. Keep the Writer page with
the clipart open. Once a greeting
card is created, just click on the
artwork page. Click on a piece of
clipart and copy it. Then click on
the Draw tab in the Taskbar, and
paste the artwork onto your
greeting card. Be sure that you are
working on Layer 4 before doing
this. Move the clipart into place
and resize it. If you are using the
clipart on the inside of the card, be
sure to invert the artwork. That
means it has to be highlighted.
Clicking on it once will allow you to
highlight the clipart. Then right-
click and select Flip, Vertically. Click
outside the clipart to set it in place.
This will complete the inverting
process.

After you have inserted various
pieces of clipart, your card is ready
to print.

ClipArt Sites:

http://www.openclipart.org
http://www.clker.com

http://www.openclipart.org
http://www.clker.com
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Guidelines

The single rule for an
article is that it must
somehow be linked to
Ubuntu or one of the

many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

Write your article in whichever
software you choose. I would
recommend LibreOffice, but
PLEASE SPELL AND GRAMMAR
CHECK IT!

Writing

There is no word limit for
articles, but be advised that long
articles may be split across several
issues. In your article, please place
where you would like a particular
image to be. Please do not use any
formatting in your document.

Images

Images should be no wider than
800 pixels, in JPG format, and use
low compression.

If you are writing a review,
please follow the guidelines shown
here.

For a more detailed list of the
style rules and common pitfalls
please refer to:
https://wiki.ubuntu.com/UbuntuMa
gazine/Style - in short: US spelling,
no l33t speak and no smilies.

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

If you can't write articles, but
hang out in Ubuntu Forums, send
us interesting forum threads that
we could print.

Non-English Writers

If your native language is not
English, don't worry. Write your
article, and one of the proof-
readers will read it for you and
correct any grammatical or spelling
errors. Not only are you helping the
magazine and the community, but
we'll help you with your English!

REVIEWS

Games/Applications
When reviewing games/applications please state clearly:

• title of the game
• who makes the game
• is it free, or a paid download?
• where to get it from (give download/homepage URL)
• is it Linux native, or did you use Wine?
• your marks out of five
• a summary with positive and negative points

Hardware
When reviewing hardware please state clearly:

• make and model of the hardware
• what category would you put this hardware into?
• any glitches that you may have had while using the hardware?
• easy to get the hardware working in Linux?
• did you have to use Windows drivers?
• marks out of five
• a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.

https://wiki.ubuntu.com/UbuntuMagazine/Style
articles@fullcirclemagazine.org
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https://spideroak.com
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Written by Charles McColm

FFoorreemmoosstt FFoorr DDaattaa RReeccoovveerryy

You know that sinking
feeling that happens
when you realize you just
deleted a bunch of

important files you really needed.
It's a terrible feeling - and often
followed by worry, panic and
repeated “why did I just do that?”
Stealing a cue from Douglas
Adams; “don't panic.” There is hope
for deleted files even if the media
has been reformatted. Foremost
can also recover corrupted files,
but it doesn’t fix corruption.

Foremost is a data recovery tool
originally written by Kris Kendall
and Jesse Kornblum, special agents
for the United States Air Force
Office of Special Investigations. It
was picked up and modified by Nick
Mikus as part of his master's thesis
and is now available in the Ubuntu
universe repositories. With the
universe repositories enabled,
installing Foremost is a simple
matter:

sudo apt­get install foremost

A word of caution before
proceeding any further - do not

mount or boot the drive you’re
recovering from. The more the
medium is accessed the greater the
chance of data loss. Before diving
in to recovering data, we make a
backup of the original medium.
One of the main principles of data
recovery is to work with a copy of
the original medium rather than
the medium itself.

Another important principle is
to back up to a medium that isn’t
the original medium (obviously you
don’t want to corrupt the drive
while trying to recover data from
it!). The drive you back up to should
have enough free space to hold an
image of the entire drive (with the
lost files). In this example, we'll
recover data from a 1GB flash drive
to a system with an 80GB hard
drive. We begin by making that
working image of the flash drive:

sudo dd if=/dev/sdb1

of=mypendrive.img

Next, we need to give the user
ownership of the image file we just
created. In this case the username
and group are called charm:

sudo chown charm.charm

mypendrive.img

Foremost recovers a lot of
different types of data ranging
from AOL .art files to audio .wav
files. Another tool photorec (part
of the testdisk package), actually
recognizes many more, but
Foremost can work with
unmounted drives and with image
files. Foremost needs a path to
save data to. This path should not
be on the original medium (or you
would overwrite data).

mkdir ~/recovery

Now let's recover some pdf and
png files:

foremost ­vqQ ­o recovery/ ­t

pdf,png ­i mypendrive.img

The -v switch enables
Foremost's verbose mode. Without
the -v switch, Foremost displays
asterisks as it processes. The -v
switch gives us nice formatted

output showing information about
what is being recovered. Foremost
can take a long time to recover
data, particularly if you're trying to
recover from a large hard drive full
of data. Verbose mode (shown
below) is nice since it gives an idea
of what's being recovered.

The -q switch sets Foremost to
run considerably faster by
searching only the start of each
sector. The large -Q switch
suppresses most error messages.
The -o switch specifies the
directory to recover to. Within this
recovery folder, Foremost creates
a folder for each type of file being
recovered. In this instance pdf/ and
png/ folders are created along with
an audit.txt file showing the same
verbose output we saw earlier.

The -t switch specifies the types
of files to recover. To specify
multiple file types separate each
file type with a comma. Lastly the -i
switch indicates which image or

441: 00702752.png 233 KB 359809024 (800 x 480)

442: 00703392.png 177 KB 360136704 (1024 x 640)

443: 00703776.png 239 KB 360333312 (640 x 360)
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LINUX LAB - FOREMOST FOR DATA RECOVERY

Charles is a step-father, husband, and
Linux fan who runs a not-for-profit
computer refurbishing project. When
not breaking hardware/servers he
maintains a blog at
http://www.charlesmccolm.com/.

device to recover from (again, it's
best to use an image file rather
than working with the original
device).

Foremost can recover erased
files, files from formatted drives,
even files that have been lost over
multiple formats. In one case we
were able to recover dozens of files
from a hard drive formatted for
ext3 which were clearly graphic
files from a previous Windows
installation.

Foremost can also recover
partial files using the -a switch
which writes all headers, skipping
error detection of corrupted files.
Corrupted files, images in
particular, are files where part of
the data has already been
overwritten. In the case of images,
the corruption is obvious - often
only part of the image is recovered
- followed by banding.

Another handy Foremost switch
is -T. It creates a timestamped
directory name. If you plan on
running Foremost multiple times
the -T switch will create a directory
name with the timestamp. For
example:
foremost ­vqQT ­o recovery/

­t pdf,png ­i mypendrive.img

In the above example, Foremost
creates a directory with a name
starting with recovery and ending
with the datetimestamp (3:29pm
here):

recovery_Sun_Mar_11_15_29_42_

2012

Foremost is a great tool for
recovering images, documents,
movies, and other types of files.
Because it can work with
unmounted file systems, it comes
in handy where other tools require
a mounted partition. Of course the
usual “back up your data” lecture
applies to any conversation about
data recovery, particularly since
there have been a number of great
backup articles in past issues of
Full Circle Magazine.

Now, at least there’s one more
option when you get that sinking
feeling that you’ve just deleted
something you really meant to
keep.

CCOODDEEWWOORRDD

Solutions are on the second last page.

Every number in the codewords grid is 'code' for a letter of the
alphabet. At the end you should have a different letter in each
numbered box, and a word in English in each of the horizontal
and vertical runs on the codeword grid.

puzzles are copyright, and kindly provided by,
The Puzzle Club - www.thepuzzleclub.com

http://www.charlesmccolm.com/
http://www.thepuzzleclub.com
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CCLLOOSSIINNGG WWIINNDDOOWWSS TTaasskk MMaannaaggeerr

Written by:
Ronnie Tucker (KDE)
Jan Mussche (Gnome)
Elizabeth Krumbach (XFCE)
Mark Boyajian (LXDE)
David Tigue (Unity)

Windows task manager
can be both a
blessing and a curse.
On one side it can

quickly and conveniently let you
close down problem applications,
but on the other, it can bring your
entire system to its knees. The

same is true with Linux task
managers, but thankfully Linux has
a more reliable way of closing down
troublesome applications, so if
you’re careful you can easily close
down an application without
freezing your entire system. The
task manager can also give you
performance information such as
graphs which come in handy.

The Windows task manager can
be quickly accessed by right clicking
the task bar and choosing ‘Task
Manager’ and a process can then be
closed by clicking the name in the
list of processes and clicking the
‘End Process’ button at the bottom
of the window.

DISCLAIMER: Be very careful of
what you kill in your task manager
as it could potentially shut down
your system, losing your unsaved
information. I doubt you’ll be able
to do any permanent physical
damage to your system, but
beware!

Kubuntu

The Kubuntu task manager
equivalent is the KDE System
Monitor and can be found in K >
Applications > System > System
Monitor.

In the Process Table tab it lists
all the processes running on your
system. You can sort the list by

clicking Name, CPU %, Memory, etc.
Stopping an application can be
done by clicking its name then
clicking the ‘End Process’ button at
the top of the window. Again, be
careful of what you’re ending.
You’ll notice that some processes
will have the username ‘root’ or
your username. This is who started
that process. In short, if root
started it, leave it alone!
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The System Load tab will show
you a real-time graph of how your
system is coping with all the
processes currently loaded.

It is possible to add more
information to the KDE System
Monitor, but I like to keep my
monitor like me, simple.

Gnome-Shell

In Gnome-Shell the System
Monitor can be found in menu
System > Administration > System
Monitor. It’s a program with 4 tabs.
Each tab shows different
information about your computer.

The first tab shows general info
about your systems software and

hardware: which OS do you use
(obviously Ubuntu, in my case
11.04), which hardware (amount of
memory and what type of
processors) and the system status.

The second shows running
processes. Which processes are
shown (yours, active or all)
depends on a setting in menu View.
The processes can be sorted in

various ways. Just click on the
column head to choose on which
column the processes have to be
sorted. I often use CPU, after
clicking this column twice you see
the processes which use the CPU
most, on top of the list. For each
column you can choose if you want
the sorting order to be ascending
or descending by just clicking the
same column head again.

On this tab you can End
processes which are not doing
what they are supposed to do. Just
click the name of the process and
click the “End Process” button. If
this does not work you can also
right-click the process and choose
Kill Process. This is, however, a way
which should be avoided as much
as possible, since strange things
could happen, depending on the
process you try to kill.

In the system monitor you see
the actual CPU usage, used amount
of memory and the network
history in a graph. This can be
useful when you experience a slow
system. Just have a look to see
how much CPU is used, how much
of your memory and also the swap
memory is in use, which could be
an indication that you are trying to
do too much with your system. If
so, then switch back to the
processes list to find out which
process eats all CPU power.

The last tab shows you the size
of your disk(s) and partitions, the
amount you use and what is still
free and it tells you which file-
system you use (in my case ext4).

Lubuntu (LXDE)

Lubuntu keeps to its “less is
more” philosophy by providing a
simple but effective task manager
application called LXTask. As with
most things in Lubuntu, you open
the Task Manager from the main
menu; select System Tools > Task
Manager.

By default, you will get a
“detailed” view displaying only

CLOSING WINDOWS
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“user” tasks (services). The view
can be altered by clicking on View
in the main menu; you can choose
to display: “user” tasks, “root”
tasks, and “other” tasks, in any
combination. Also note the “more
details” button in the lower left
corner of the Task Manager
window. This button is “on” by
default, displaying 9 columns of
data (as shown). Deselecting this
button will limit the number of
columns to 4: Command, CPU%,
RSS (Resident Set Size), and PID.

The only “graphs” displayed in
Lubuntu’s Task Manager are the
two bar graphs shown at the top of

the window: CPU Usage (on the
left) and Memory usage (on the
right). The latter is displayed
without showing cache, but this
can be changed in the View menu if
you wish.

To take control of a process
listed in the Task Manager, right-
click the desired task to get an
actions menu. Using this menu you
can Stop, Continue, Terminate, or
Kill the task (you can also change
its priority). These options appear
in order of severity: If you Stop a
process, then you can start it again
by selecting Continue. If you want
to “end” the process completely,
then select Terminate. If selecting
Terminate fails to “end” the

process, then you can select Kill;
however, as mentioned above, this
is the “method of last resort”
because it could have unintended
side-effects on other running
processes.

When you are finished
monitoring and/or manipulating
your tasks, clicking the “Quit”
button in the lower right-hand
corner of the Task Manager
window will close the Task
Manager.

NOTE: If you have the system
resources and you want the
additional functionality provided
by the Gnome System Monitor (as
described for Gnome Shell), then

you can always install it in Lubuntu
using the package manager. And,
of course, you always have
immediate access to the terminal
which puts the full power of the
Linux command line at your
fingertips. “Top” is the command-
line task manager which uses few
resources.

Xubuntu (XFCE)

You can find the XFCE Task
Manager (xfce4-taskmanager) by
going to the Mouse menu > System
> Task Manager.

By default you will get a basic
view of services running, but you
can list all processes by clicking on
Preferences and selecting “Show
all processes.” Through this
Preferences menu you can also
toggle the precision with which it
tracks CPU (rather than full
percentages, it can go to the 2nd
decimal place), full command line
view and adjust the refresh rate in
several increments from 500ms to
10s (default is 750ms).

You can sort processes by any of
the columns in descending or
ascending order by clicking on the
title of the column. The

CLOSING WINDOWS
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CLOSING WINDOWS

Preferences also allows you to
adjust the columns you wish to see,
allowing you to add the PPID
(Parent Process ID), State, Virtual
Bytes, UID and Priority, all of which
are sortable.

At the top of the Task Manager,
next to the Preferences button,
you also have a built-in CPU and
RAM monitor, which will give you
the percentage as a number if you
hover over them.

In order to manipulate a task,
you right click to get a menu which
offers options to: Stop, Kill,
Terminate or “Priority” which will
show a sub menu of priorities you

can change the process to from
“Very low” through “Very high.”

When you are finished with Task
Manager you’ll want to click on the
“Quit” button, if you simply close it
by pressing on the “x” at the top of
the window it will simply minimize
to your panel.

Unity

In Unity, just like with Gnome-
Shell you will use the “System
Monitor” application. The easiest
way to open the application is by
clicking the “Dash” button and
typing in “system monitor”, an icon

will appear with a “System
Monitor” label underneath it. Click
the icon and the app will open.
Now you can click on the processes
tab to see all processes running on
your system. Be very careful when
using this to close applications.
Another way to close applications
that I would like to mention is
“xkill”. If you have an app that is
frozen or unresponsive then use
xkill to get rid of it. All you have to
do is hit the Alt+F2 key
combination and it will pop open a
dash-like window where you can
type in applications you would like
to run. When it does open simply
type in “xkill” and an icon
resembling a gear with the label of
“xkill” below it will show up. Click
the icon and your mouse pointer
will turn in to an ‘X’. Now that the
mouse pointer is an ‘X’ all you need
to do is click on the application that
is frozen. The application will be
killed immediately and you can
continue working. Another
application that some like to use
(including myself) is called htop. It
is an ncurses based command line
tool. Don’t get scared, it’s easy to
use. First you’ll have to install it.
Open the command line by clicking
‘Ctrl+Alt+T’ then type ‘sudo apt-get
install htop’, once it is done
installing you can run the

application by typing ‘htop’ at the
command prompt. The application
will open showing you all the
processes running on the system.
You can use the arrow keys to
navigate to certain processes.
What I like to do first is hit the ‘U’
key and then use the arrows to
select my user. With my user name
highlighted I then hit enter and
htop will only show the processes
being run by my user. Then you can
hit the ‘k’ key which stands for kill
and then use the arrow keys to
highlight the process you want to
kill. Once the process is highlighted
just hit the ‘Enter’ key and it will kill
the application. Please be careful,
even when only showing your
user's processes you can still risk
losing unsaved data by killing
certain applications. If you are
unsure about an application, a
general rule of thumb is DO NOT
KILL IT.

Next month we’ll look at
selecting/changing sound
devices, sound volume/mute, and
recording inputs.
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MMYY SSTTOORRYY
Written by the MyUnity team

R
ecently, the adoption of
Unity (a new desktop
management system) by
Canonical has led many

users to complain about the
inability to customize it. In fact, you
can manipulate Unity via: CCSM,
Ubuntu Tweak, gconf-editor, editor-
dconf.

Some months ago up popped
another program: MyUnity. In little
time it has become appreciated by
users due to two ingredients:
simplicity and aesthetics.

We talked to the two main
developers of the tool to see the
idea behind MyUnity and what
plans they have for the future.

Thursday, October 27,
2011

UIELinux, a LUG in Italy, usually
takes place on Thursday evenings
over a beer and bowls full of
popcorn at the pub Mapaleo
Savignano:

Davide: .. finishedinstallingUbuntu,

the first thing Ido is reduce the font.

On 11 Ido not like it, it's too large. I

trybutcan notfindthe font

manager. Didtheymove it

somewhere I'm saying. But it's not

there. Natty in there!

Fabio: You can do it. From gconfyou

can do everything: font, launcher,

themes, icons, everything.

Davide: Sure I can do it, but that's
not the point: I expect to finda

system tool thatallowsme to do it

with ease. Gconfis notexactly the

mostuser-friendly, do notyou think?

Fabio: Mah. Ido notknow, in my
opinion is notnecessarybut sooner

orlater, Canonicalwill do anything.

Davide: But in themeantime there is
nothing. Putyourselfin the shoes of

someonewho has neverseen

Ubuntu.

Fabio: Ok, Iwill think.

The Birth Of MyUnity

During the following Saturday
and Sunday Fabio writes the code
that will be version 1, Davide
designed the aesthetic part of the
GUI and Sergio creates the logo
and icon.

After uploading to the network,
a word of mouth among users and
with hundreds of link hits every
hour, everyone wants to configure
Unity.

In the beginning we got advice
and suggestions from individuals,
and various articles that appeared

in journals and blogs that
encouraged us to improve the
characteristics of this simple
configurator.

On the recommendation of
Paolo Sammicheli (Ubuntu), and
bringing Andrea Colangelo (Ubuntu
MOTU) into the team, the
LaunchPad project begins and
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MY STORY
starts to take shape in a much more
structured and uniform way.

The structure of the source is
modified to meet the strict criteria
of the packages.

Meanwhile, Davide and Sergio
continue to modify the GUI and
bake in version 2.0 on December
10: In the blogosphere you multiply
the positive comments.

With the arrival of Precise
(12.04) and the new version of
Unity, the code undergoes a
significant modification enriched
with additional setting possibilities.
With the help of Stefano "Teo"
Teodorani and his precious script,
we can also manage themes and
icons.

Davide certainly can not think of
using the GUI of 2.0 and 3.0, so
MyUnity is forked while Andrea
asked Canonical for a chance to put
the tool in the official records.

With the release of version 3,
Davide also created the official
website of the project which
includes pictures and comments,
while Marco "Markuz" Sgarzi deals
with translation into English.

Why has it succeeded?
Davide was right, users wanted the
freedom to manipulate Unity.
We like to think that the simplicity,
immediacy and visual impact have
in part contributed to the success.

Why have you written in Gambas?
The reason is fundamental and
unavoidable, as Davide and I both
know this language very well .

The speed with which you can
create applications, however, is
considerable and this choice has no
influence on the success.

MyUnity compared to Ubuntu
Tweak, what do you think?
MyUnity is a tool designed to
configure the Unity environment
and nothing else, with the utmost
simplicity. Any modification occurs
in a user space, thus avoiding
disrupting the system. Restoring
the default settings to run any test
is easy and safe.

Ubuntu Tweak is a very
powerful tool. It offers many
settings and manipulations at a low
level, but not all users understand
or know what to do. When you
drive a car you know how powerful
the accelerator can be and must be
used correctly, otherwise there is

serious trouble.

MyUnity and Ubuntu Tweak are
two very different applications.

These days more configutation
tools are appearing, are you
afraid that they might exceed the
popularity of MyUnity?

MyUnity is an exchange of opinions
that was born at the bar in front of
a good beer. All'nizio was more of a
challenge, because there was no
such thing. If Canonical chooses to

fill this gap by creating a tool for
Ubuntu ad-hoc so be it. I do not see
the problem, and that's the beauty
of free software: everyone can do
something better (or worse) for
the community.

What can we expect from future
versions?
In 3.1, which will be released soon,
we have solved a number of bugs
including the recognition of
Unity2d. We believe there is still
considerable room for
maneuvering the various settings
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MY STORY

that can be added. But it is
essential to balance the ability of
making changes with the ease of
use. You should not feel displaced
or distressed, but understand
immediately what to do to get the
desired result. The simpler the GUI,
the less need there is for
instruction manuals.

Current version: 3.1
http://www.uielinux.org/myunity
https://launchpad.net/~myunity

Team:
FABIO Colinelli (Italy) Core
developer
pixel.ubuntu@gmail.com
www.ubuntu-it.org
DAVIDE Pedrelli (Italy) GUI

developer
pobox.davide@gmail.com
www.uielinux.org
Sergio Gridelli (Italy) Graphic
developer
sergio.gridelli@gmail.com
www.uielinux.org
ANDREA COLANGELO (Italy)
Package maintainer
warp10@ubuntu.com
www.andreacolangelo.com
STEFANO Teodorani (Italy) bash
script consultant
s.teodorani@gmail.com
www.uielinux.org
MARCO Sgarzi (Italy) Web site
translator
msgarzi@gmail.com
www.uielinux.org
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Solutions are on the second last page.

Numbers 0 to 9 and letters A to F are to be filled into the
16x16 grid so that every row, every column, and every
4x4 box contains 0 to 9 and A - F.

Puzzles are copyright, and kindly provided by,
The Puzzle Club - www.thepuzzleclub.com
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MMYY OOPPIINNIIOONN
Written by Chandra

In 2008, I was still using a 20
year old DOS computer (!) -
when it became obvious I
couldn’t go on without

connecting to the web. I bought
one of the very first netbooks
because it was funny and cheap.
Linux was one of the reasons for
the low price, and I knew nothing
about this strange thing. But I
discovered that it was possible to
buy a computer without paying
what I call the “Microsoft tax”, so
to speak. I added an external
CD/DVD rewriter.

The original distro was
Xandros... not a very good one in
fact. The possibilities were very
limited, and I rapidly looked for
something else. The problem was
to find a distro working out-of-the
box on an EeePC, and it was not
easy in those days. I started with
ubuntu-eee (an Ubuntu 8.04 fork
which became easypeasy). The
main problem was the kernel:
ubuntu-eee was using a specific
kernel and it was not possible to
easily upgrade it when a new
Ubuntu version was available. I
tried livesessions of eeedora,

eeedebian, and Linux Mint, and I
finally switched to Ubuntu 8.10 on
my netbook - and on my new
desktop computer too (I bought a
“naked” Nyos 50 not to pay the
“tax”).

In the meantime, I was gradually
discovering Linux - thanks to
forums, magazines, and on-line-

documentation. Everything was not
yet working out-of-the box : e.g.
the WiFi LED or the volume control
on the netbook, but I succeeded in
fixing those little problems. Within
a year and a half, I definitely
dropped out everything that was
coming from Microsoft, and my
configuration was OK regarding
what I wanted to do with it.

Then, Unity arrived! I’ll just say
two things about that. To me, Unity
is a real nightmare. It is also a
solution for which there was no
problem. So, I switched to
Xubuntu. It is very simple, very
intuitive, faster, and very easy to
configure. Since it uses gtk
libraries, gnome applications are
welcome. Xubuntu is now the only
distro I use.

Oh, by the way, what do I use?
Very simple but powerful things:
Firefox and Thunderbird, Abiword,
and Gnumeric. On a second level,
eog as an image-viewer, epdf as a
pdf-viewer, Xsane as a scanner,
GIMP, MPlayer, devede, brasero (if
you want to know more about
these programs, please refer to
the ubuntu-on-line-
documentation). I also use
products such as gparted, baobab,
mousepad, gnome-disk-utility,
hardinfo, ntp, wipe, clonezilla...

And now, what is important to
me? First of all, I do not have to
adapt myself to the distro. The
distro must be able to adapt to me.
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MY OPINION
I must be able to control precisely
what I need, and to remove all that
is not necessary to me. That is why I
don’t use Ubuntu Software Center,
which is just a pleasant catalogue
to look at. It’s not precise enough.
It does not allow me to completely
remove unused packages, that is to
say to also remove configuration
files. I added deborphan in
synaptic, which allows me to
remove orphan packages. I also
removed about forty or fifty non-
useful things. For example, dummy
packages or things like splx - since
my printer is not a Samsung printer.
This is important because my
netbook has only a 4GB SSD.

I must be able to completely
personalise the desktop so that
everything is located where it has
to be, and behaves the way I want.
Fortunately, Linux allows any user
to modify little things in
configuration files. For example, I
changed the 3600 seconds random
sleep time to 10 seconds in
/etc/cron.daily/apt. Otherwise,
when I start my computer, it may
take more than half an hour before
I am told about available updates.

Upgrading to new versions is a
real problem which bothers me.

First, upgrading should be as
simple as updating. And it’s not.
During the very long upgrading
process, I generally am asked to
choose either the new version of
an unknown configuration file or to
keep the old one. I don’t know
everything about Ubuntu, so I
know nothing about the
consequences of the choice and I
don’t know what to do. I generally
choose at random. After the
process, I discover applications
have been added. For example, I
chose mousepad and eog. Why
install leafpad, pidgin (which I don’t
use) and ristretto, that I had
previously removed ?

Second, all that was working
before should work after. And all
my personal choices in the
different preferences and
configuration files should stay
unchanged. After upgrading, things
have disappeared, such as certain
icons. Other things simply don’t
work any more. For example, ADSL
connection, from Jaunty to Karmic.
I had to add sun-java-plugin after
upgrading to Lucid because
icedtea-plugin was unable to
display websites which it did
before.

Third, depending on how I do it,

I don’t exactly get the same thing. I
use a single ext4 partition, and no
swap, and I have tried four
different ways to switch to a new
version.

1 - I use the very long upgrading
process. It generally takes at least
four hours time to upgrade, fix
what no more works and remove
the unusefull things which have
been added. There is also another
problem in this process. Some new
features are not available. For
example, I had to manually switch
from grub-legacy to grub-pc in
karmic.

2 - I make a fresh install, which is
the best way to get the real new
version. But I have to re-
personalise everything. And it
takes a very very long time.

3 - I make a fresh install WITHOUT
formatting the old ext4 partition,
which keeps my /home directory.
But the result is not exactly the

same as the one I get with the
previous possibility. Pieces of the
old version are not completely
removed.

4 - I use two partitions : / and a
separate /home partition and I
then make a complete fresh install
which keeps my home directory.
But I have to remove what is not
necessary to me. That’s what I’ll do
with Xubuntu 12.04 LTS.

So, the ideal upgrading process
doesn’t exist. Anyway, the good
new is that facing problems is an
opportunity to learn something
and to grow up. And of course, I go
on with Xubuntu, the best distro
for me.
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II TTHHIINNKK...... What turns you to/from a distro?
Last month's question was:

What turns you away from a distro?
And what turns you to a distro?

A desktop environment which is
ugly and does not match the way I
work.
Boot speed, configurability.

Repositories with not much that I
want in them, and no repo for that
distro (e.g OpenSUSE)
Everything working out of the box

No or poor drivers for my
hardware; changing default app
content; over-ambitious desktop
GUI
Quick boot; non-alignment to a
particular problem (e.g., to music
production); constant
improvement, particularly in the
kernel

Lack of application updates and
delayed security fixes.
Strong leadership team and
enthusiastic community support.

Many default apps for the same
purpose being installed and having
strange settings

Room for customization and not
many required reboots

Unwanted and silly changes like
Unity
Good language support, possibility
to work fast and effective, easy to
use

Easy to install and no futzing with
drivers - audio, video, printer,
wacom. It should fully work
together. Recent upgrade went
through three distros to find one
that just worked.
It works perfectly after install. No
wandering through forums to get
audio to work; no tracing obscure
issues in video, no desktop GUI
issues. IT JUST WORKS. Am I there
yet? Nope. Closer than on some
other distros.

When the upgrade changes, or
removes all the things I liked in the
first place
When it has all the apps that I want
- without forcing anything I don’t
want, on me

Hardware drivers, I tried to install
Debian on my laptop and was

unable to use it because of lacking
wifi driver, Kubuntu worked fine
User friendly, configurable, good
community, it just works

Gnome 2 was fine and I think
Gnome 3 should be OK. Everything
on my screen is much too big. I
don’t like launching/switching
buttons like in Windows 7 and
Unity. I don’t like having to type in
the name of an application in a
search field. I don’t like configuring
compiz-fusion, which is totally
incomprehensible. I don’t like the
big icons all over my desktop.
Matureness and features are
lacking.
I like thin tool bars with small
buttons. I like distinctive buttons
that tell me which applications are

open. I like to be able to chose
easily what will be on my toolbar. I
like the menu of applications to be
organized by category. I like to be
able to drag-and-drop between
posts in Thunderbird – not possible
in Unity. I like my iPod to be
recognized by GTKpod when I plug
it in. I like the weather to be in
French at the top of the control
panel, even though I live in
Quebec. I like to be able to erase
the history of recently opened
applications. I’m a pretty
knowledgeable user and I don’t
mind getting my hands dirty, but
there’s a minimum that a
distribution should allow you to do
easily. I’m using Mint LMDE while
waiting for Gnome
3 and Gnome shell.

This month I'd like to pose the question:

Ubuntu 12.04 will be released on the
26th of April. Will you be upgrading?

To give your tuppence worth go to: http://goo.gl/Ms7jI

Closing date for this question is Sunday 08th April 2012.

http://goo.gl/Ms7jI
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RREEVVIIEEWW
Written by Art Schreckengost

Those watching the
Distrowatch page hit
listings have probably
noticed an oddly named

entry that stayed in the top 25 for
a good chunk of 2011. Called
Bodhi (current version is 1.3.0) it
not only made this level in just over
a year of release (for all versions)
but managed to do so using
Enlightenment 17 (e17) as a
desktop shell.

What is e17?

Enlightenment is a desktop
shell, much like Gnome and KDE,
that has been in development for
nearly 15 years. I've worked with
just two versions, 16 and the
current 17, the latter having been
in various alpha/beta stages for the
past 5 or so years (if you want to be
technical, e17 is really 16.999 but
what's .001 among friends?).

Although initial development
focused on low base spec
computers, current testing is
geared to multi-core processors
with higher RAM counts, although

e17 is at home in either setting.
Base code is somewhere around
25MB (Gnome and KDE are 10
times that amount) with Bodhi's
version undoubtedly being more
due to eye candy and tweaking.

As options go, Enlightenment
never really caught on, and was
overshadowed by others in the
“light”category such as Xfce or
LXDE . Anybody care to remember

the ill-fated gOS venture of 2007-
08 or OpenGEU from 2009, both of
which took a powder after
relatively short runs? Even
moonOS defected to Gnome after
version 3, thereby abandoning e17.

This is unfortunate, since e17
holds promise as a highly
customizable shell, but an early,
unreliable e16 version left a bad
taste with many users, and the

stigma still lingers. Of note,
Synaptic still lists e16 although it's
not advisable to consider using it.

Although there may be others, I
know of just one OS other than
Bodhi that is Ubuntu and e17
based, and that's ExLight from
Sweden (don't bother looking, it
doesn't rate mention at
Distrowatch).

The Basics

Bodhi is not quite as foreign as
the name may indicate. Properly
pronounced Bo-Dee (not Bod-Hi or
Bod-He as I thought) it hails from
the States, and the lead developer
is Jeff Hoogland. The name is
Sanskrit for enlightenment,
appropriate given the shell.

Unlike other distributions that
change base code as Canonical
does, Bodhi has always used 32-bit
Lucid Lynx (10.04 LTS) and has a
downloaded image of roughly
375MB.

No other way to say it, but
Bodhi is minimalistic and included

BBooddhhii LLiinnuuxx
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programs are limited to the Midori
browser (with private browsing),
LXTerminal, PCManFM (file
manager), Leafpad (akin to MS
Notepad) and Synaptic Package
Manager. The original Bodhi
release, 0.1.6, came with Firefox 4
beta but that was discontinued,
possibly to save space although the
extra 40MB or so would still leave
plenty of leftover room on a CD.

Website

After years of reviewing OS
websites I've pretty much got the
pattern down. Usually a home
page, another to highlight the
developers and sell paraphernalia
and, finally, one that offers the
actual download. Occasionally a
forum or FAQ page is thrown in but
most information is often stale and
it has become obvious developers
are phoning it in (the thrill is gone,
baby).

But www.bodhilinux.com is the
rarity in the bunch, with
comprehensive and relevant
information, additional program
offerings that rival many
repositories, tutorials aplenty and
well staffed forums with questions
often answered in minutes. In

addition, it's well designed and
visually appealing.

Whether or not they meant to,
Bodhi developers have better
Enlightenment tutorials on their
website than the Enlightenment
website itself (check it out at
www.enlightenment.org).

Installation

Normally I don't elaborate on
live mode since it's the usual
CD/DVD spin and grind, but Bodhi
has a couple of additions to the

routine that merit attention.

Two choices must be made prior
to a complete boot, with the first
being a profile, what you might call
a desktop layout. These range
from Bare (wallpaper and nothing
else) to Compositing (a modified
Compiz code for e17). In between,
you'll see offerings for laptops,
desktops, netbooks and tablets,
with each showing specific
engineering and design traits.
There isn't a bad choice in the
group, although Bare dispenses
with everything but a background
and may be too light for most.

Then you have to pick a scheme
from a palette of several, all of
which are artistically pleasant, so
just click on one since any choice
from these two areas can easily be
changed later.

The last stumbling block
involves default backlight settings
that are pegged to dark, for lack of
a better description. This requires
a trip to the settings menu, kind of
hard when the screen resembles
NYC during a blackout (have a light
nearby). My previous e17 tests
didn't exhibit this characteristic so I
can only assume it's a Bodhi tweak.

Even with all this, live mode
boot times averaged 2 minutes;
however, continued use of this
mode is a bear since any changes
made will disappear when the
power does. Those desiring
portability are advised to visit
www.pendrivelinux.com for info on
creating persistent USB drives (i.e.
drives that retain changes).

So it was full installation, but
there is a pleasant surprise in this
option. Care to guess how long it
takes – 30, 45 or 60 minutes?

http://www.bodhilinux.com
http://www.enlightenment.org
http://www.pendrivelinux.com
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How about 8? You read right, 8

minutes. Resetting backlight
settings and 50MB updates took a
couple more, so I was out all of 15
minutes, tops. Quite impressive
given that previous tests with e17
based distros never produced such
stellar times.

The only other issue is a final
screen hang. When all is said and
done, the CD ejects but the final
splash screen (nicely designed with
small green leaves cascading left to
right) refuses to close. Let it do
the leaf dance for a couple minutes
and then hit enter. It never hangs
again.

If you're wondering, Bodhi takes
roughly 2GB off your hard drive
post-install.

Desktop Design

Even with entering user ID and
password, cold boot times are a
respectable 30 seconds or less.
Those familiar with Fedora 12 will
recognize the blue bar that creeps
from left to right on the screen to
indicate boot progress (no boot
music, though).

As much as I'd like to describe

the first desktop, that's sort of
difficult since so many choices are
offered; however, some attributes
are the same no matter what, and
those I'll discuss.

You can quit looking for desktop
icons. There are none, nor does
e17 allow for them. No trashcan or
home folder icons, nor is there
anything for attached external
drives or cards. You'll have to
access these via the home folder
off the main menu.

Instead, e17 uses shelves (a.k.a.
docks), modules and gadgets.
Shelves can be placed anywhere
along the borders, and you can
install several. Modules and
gadgets can then be inserted into
these shelves (such as iBar, a
module that allows for program
icons to be dragged and dropped).

An unfortunate aspect of e17,
and possibly one of the reasons it
never became as popular as Gnome
or KDE, is that the protocol for
adding, deleting or modifying any
of these areas can be
overwhelming for the uninitiated.
Settings under the main menu have
roughly 14 categories, that open to
expose nearly 80 subcategories.
Hardly intuitive, and most will have

to spend time just to get the menu
map memorized. Once deciphered
it becomes second nature.

For example, changing backlight
settings requires 7 to 8 clicks or
mouse movements and is hardly
intuitive. Most newbies will
undoubtedly be overwhelmed the
first time.

As for main menu access, you
have two choices, the first of which
is to click the Enlightenment or
Bodhi button found in the left
corner of most shelves (except for
the Bare design – it has no shelves).
This opens a Gnome-like menu.

The second option is to left-click
an empty desktop area, but make
sure you're not too close to the
right side of your screen. E17
menus are limited to right-hand
cascading and being too close to
the edge will cause it to disappear
into cyberspace. Move to the left
to alleviate that issue.

One other peculiarity of the e17
menu design is that the main menu
is not static in left-click mode, that
is, both the main and secondary
menus cascade up and down when
scrolling through program listings,
so it's possible to have the main

menu disappear off the screen
when scrolling.

As for the right mouse button,
it's active only when used on
shelves, modules or gadgets and
then only to reset or choose
options for those areas; however, if
programs are added to favorites,
right-clicking an empty desktop
area will produce a menu of those.

In essence, plan on taking some
time to learn these procedures.

Operational Efficiency

E17 is fast. Amazingly,
blazingly, blindingly fast. Without
a doubt the fastest desktop shell
I've ever used. Programs snap to
attention within a few seconds.
LibreOffice Writer opens within 5
seconds and Gimp is ready to use
within 10. Either of these
programs in Gnome or KDE would
take 3 to 5 times longer to open on
my system.

Even more surprising is that
resource usage rarely peaked
above 20% and settings could dip
as low as 2% at idle.

Hardware acceptance was
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exemplary, with no downloads
necessary, an oddity given that
usually 1 or 2 are necessary with
Gnome or KDE. Wireless, video and
audio were operational from first
boot, and I was happy to not see
that aggravating “AMD
Unsupported Hardware” pop-up.
About the only thing missing is a
printer driver set, but that can be
added (read below for that).

Wish I could give kudos for
battery consumption and
generated heat but Bodhi is no
better than Gnome or KDE
counterparts in this category,
rather odd given that resource
usage is so low.

Adding Programs

Bodhi is purposely light, so
users can make their own program
additions, and believe me when I
state you probably will. Midori is a
mediocre browser and LeafPad is
equally dismal as a text editor.

Since e17 is neutral it will accept
both Gnome and KDE programs,
but there is a protocol that must be
followed and is stressed at the
Bodhi website.

There are four ways of adding

programs – apt-get, modified apt-
get, the website or Synaptic.

Of these, the website is my
recommended first stop.

Midori defaults to the Bodhi
website. Go to AppCenter under
the Resources heading and you'll
see a boatload of program choices
including the Nikhila and Pratibha
packages.

Nikhila (Sanskrit for “whole,
entire, all, complete) is 530MB and
includes Mirage, Adobe PDF

Reader, Cheese, Firefox, gEdit,
Handbrake, k3b, LibreOffice,
Okular, Openshot, Qalculate,
Pidgin, Printing, Rhythmbox,
Shotwell, Simple Scan,
Thunderbird, Transmission, VLC,
Xchat and Filelight.

Pratibha (“light, splendour,
intelligence) is 157MB and packs
Claws, DeadBeef, ePDFView,
ePhoto, Geany, Light Office
(Abiword plus a couple others),
Pinta, Qalculate, VLC, Xchat and
Xfburn.

Specific packages for Audio,
Image, Scientific Publishing,

Educational, Web Development,
Online Media, Icon Sets and GTK
Themes are also highlighted along
with service packs, Internet
specifics, graphics, kernel
upgrades, multimedia,
Enlightenment modules and
assorted extras.

Although some apps are
repeated in various categories, this
all adds up to a whopping 2.5GB +/-
larger than the initial Bodhi
installation uses on the hard drive.

Not only do your have programs
galore but you'll see options to
install or download them. "Install"
downloads and installs chosen
programs, with little user
intervention, but is designed to be
used by Midori or Firefox browsers
(the files have .bod extensions).

"Download" is not browser
specific since it merely parks files
in the Home folder for retrieval
later.

While this is simple enough,
using Synaptic and/or apt-get can
present difficulties. E17 has no
problem accepting Gnome and KDE
programs but it does find related
dependencies and “recommended”
files hard to digest, and both
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techniques load them by the
bushel.

This is where the modified apt-
get comes into play. The usual
command line would be “sudo apt-
get install” along with the program
name, but developers recommend
you use a different approach with
“sudo apt-get install –no-install-
recommends” with the program
name. This effectively halts those
extra, unnecessary dependencies
(this technique is also mentioned
on the Ubuntu website).

Does it work? Both Synaptic
and apt-get attempted to retrieve
660MB of files when I downloaded
Kile, a LaTeX processor, but using
the modified apt-get command
reduced that figure to just 80MB
and it works perfectly. So, yes, it
does work.

While you can add Ailurus,
Ubuntu Software Center or Ubuntu
Tweak as package managers, they
can be used only as root (which
means the added menu entries are
for show only) necessitating a
terminal sudo command (ailurus,
software-center or ubuntu-tweak
preceded by sudo), but the risk of
including yet unnecessary files will
still be there.

I learned to use these package
managers as a means of spotting
programs of interest and then
using the modified terminal
command to actually install them.

What happens if you don't
follow this protocol? As I
discovered, you may notice
programs start to slow down, e17
may occasionally crash and login
options may change to include
Gnome and KDE desktops (they are
bare-bones Openbox versions with
wallpaper and zero else).

While slow programs are a
problem, an e17 crash is a perverse
blessing of sorts and is the polar
opposite of a Windows BSOD.
Shelves, modules and gadgets all
disappear along with the capability
of shutting down except by
pushing the power button, but
programs still work and open
documents can be saved without
any loss. In fact, I once went over
an hour with a crashed desktop and
lost nothing (the only oddity is that
the left click menu still works to
open programs but it can't be used
to shut down or log out – that part
of the menu vanishes).

Final Analysis

E17 is an odd choice for a
desktop shell but not a bad one in
the long run. It's fast and, for the
most part, reliable. Play by the
rules, add programs properly and
you'll have no problems.

I did have the usual snafus with
disappearing shelves and the odd
gadget or two that failed to always
work, but that's life. I've had the
same issues with Gnome, KDE and
Windows. Nothing is perfect, even
the much-vaunted OS X has its
issues.

As a comparison I installed Xfce
as a login option, and was
somewhat surprised to see it used
double the resources, and
programs were noticeably slower
to respond. While I didn't have to
watch for Gnome or KDE
dependency snafus, continued
usage became laborious compared
to e17.

Truthfully, I went into this
review biased concerning
Enlightenment's past issues and
knew they would get in the way;
however, I must admit Bodhi is
really impressive. It's fast and well

designed, and the website is
second to none.

All things considered, Bodhi is a
stellar choice for those looking to
start with a minimal system, and
build it up with what they like.
There is nothing to indicate it can't
be a daily user.

I'd give Bodhi 4 out of 5 stars
with a drop of one only because it
has a learning curve that may
confuse some, and a desktop shell
with a few quirks that necessitates
caution when performing some
actions, such as adding programs.
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Every month we like to publish some of the emails we receive. If you would like to
submit a letter for publication, compliment or complaint, please email it to:
letters@fullcirclemagazine.org. PLEASE NOTE: some letters may be edited for space.

Full Circle

I must admit that, when Unity
and gnome 3 came out, I
wasn't really enthused about
either OS. I "cut my teeth" on

Ubuntu (circa 2005) and had used it
until about 1 1/2 years ago - when I
switched to Mint. Just liked their
presentation and ease-of-use.

When Unity came out, I just
couldn't like it. I tried the new Mint,
which was nice, but didn't give me
the control or visual confirmation,
I.E. when just glancing down at the
menu bar I knew what apps were
running even if I was running 4
desktops.

In December with all the
changes, I have come back almost
"Full Circle" (pardon the pun) to
Kubuntu.

It is fast, I can customise it as I
am used to, and it is reliable. Can't
wait for the LTS version to come
out. Then I am set once again with
the *buntu family.

I have been reading FCM since

its inception, and like the way it is
presented. I have DVD's with
almost all FCM editions. Just the
last few haven't been burned yet.

Don't get discouraged. We're
still out here, some may wander
once in a while, but will probably
come back to one of the many
*buntus.

Tom L

Windows 7

I have been using Ubuntu as my
main computer's OS for some
years now, but still find it
necessary to run Windows 7 in

a virtual machine, which I hate
doing. Admittedly, I use Windows
for far fewer things as time goes
by, but I can't just get rid of the
final few! All the big stuff is now
covered more than adequately by
Linux - it's now the small items
which are used alongside hardware
peripherals which cause the
problem. For instance, I have a
Garmin satnav which I use

extensively for travelling. I have a
lifetime map upgrade subscription,
but - guess what - I can update the
Garmin device only through
Windows (or a Mac).

I use Evernote extensively - I
have it on my phone and tablet
(both Android), but I have to use
Nixnote on my main PC - the
Nixnote team are doing a great
job, but the program just isn't as
slick or nice looking as the
Windows version. I have used it
with Wine, and it works, but is so
slow that it's relatively unusable.
Evernote responded to my queries
by saying that they weren't a big
enough company to make versions
for all the minor OSs.

I have an excellent Android
tablet - the Asus Transformer. But I
can't get it to talk to my PC. Why?
Because Asus supplies connection
software only for Windows PCs or
Macs. I can, of course, get around
that, but it's still annoying.

I have a DLNA TV and Bluray
player. I don't actually know how
easily they will interface with

Windows, but I do know that it's
not easy to get them to do it
consistently and with much
functionality with Ubuntu. The
DLNA servers I have tried with
Ubuntu are flaky and difficult to
use at best, and just don't work at
all at worst. Perhaps a good article
about successfully setting this up
would be good?

I remain solidly committed to
using Linux - I do prefer it for many
things, and each version is better
than the previous one. I have a
Home Server also with music and
photos on it which also runs
Ubuntu, having originally run

Join us on:

facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

goo.gl/FRTMl

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
http://goo.gl/FRTMl
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Windows Home Server, and I would
never go back to that.

Mike Anderson

An Old Hand

I am an old hand at operating
systems, over 50 years in the
field. But forget the past! A
new year and some very

worthwhile work has been given to
you. Core Linux, Ubuntu, Linux
Mint, and so many other distros of
Linux.

Of all those that I have tried or
worked with, Ubuntu and Linux
Mint stand out. I have tried to
convince many other computer
users to get off the Microsoft
bandwagon and enjoy a far
superior system.

I have 7 systems loaded with
different Linux distros (many
multiple boot and some
Virtualbox). Now we hit a bump in
the road. The versions from Ubuntu
10.04 and the similar Mint Linux
have ventured into new concepts
that I think should only be optional.

Cloud connection and
processing is a great idea, but what
about the many users who need
the system only for emails, some
writing and spreadsheets, some
games, and for pictures and videos.
What about the open door to social
engineering (facebook, twitter, etc)
which most do not want. If they
want it, install what they need.
Security needs to be seriously
reviewed. It is amazing what I can
learn about any person by Internet
sleuthing. The old bank security
question of your mother’s maiden
name is now a joke - don't even
need ancestry.com for that...

Jim Mechtel

Google Currents

I just wanted to say a big thank
you for all the hard work which
has gone into creating the
Google Currents and Kindle

versions of Full Circle Magazine.

I think this is definitely the way
forward, as so many people now
either have smart phones or
tablets of some sort, and probably,
like myself, find themselves using

their actual computers less and
less.

Google Currents, as far as I'm
aware, isn't yet available in the UK,
however, a quick Google search for
'Google Current APK' brings up
how and where to download it
from. Be sure to have 'Unknown
Sources - Allow installation of non-
Market applications' ticked.
Currents will then download and
happily install itself.

While the Currents version of
FCM is very good, and nicely laid

out, might I be so bold as to
suggest that the odd picture here
and there may not be such a bad
thing [done! - Ed]. Totally
understand why they were left out,
however, the majority of readers
probably have a decent broadband
speed, so would be able to
download the latest version over
WiFi at home, and then have FCM
to hand wherever they go.

Bryan
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Directory Opus

I currently use Directory Opus
on Windows 7 to manage my
daily documents such as read
my pdf's, odt, doc,

powerpoint, view HTML docs,
display photos in Raw, Jpeg, Png,
Tif, Gif. The Dolphin and Nautilus
file managers leave me wanting
because they are so limited in their
ability to do all the file
management duties needed daily.
Directory Opus allows Zip/Unzip,
slide shows from your photos, plays
music (mp3), shows videos and Flv
Flash, allows setting the number of
windows to display photo
images/dual data display, changes
the size of Icons for your photos to
your taste, converts file format for
photos. Does anyone know of a
more powerful file manager than
either one of the Ubuntu utilities
that are packaged with Ubuntu &
Kubuntu. I have tried Directory
Opus and Power Desk a while ago
with Wine, and found some
incompatibilities in the way they
drew the interface so I don't really
want to go that route, I would
rather use a utility native to the
Ubuntu/Kubuntu OS. Ubuntu needs
a file management utility like this
to make daily work easier since it

does not require a person to keep
opening separate programs just to
view or play something. You may
just want to look rather than
modify something and a utility like
this is very helpful.

Brian Hartnell

Ronnie says: I can’t help you out
with a filemanager, but I think the

last time IusedDirectoryOpuswas

on myAmiga A500. Ah, the

memories!

Gord adds: To a large extent, the
whole philosophyofLinux is to have

small programswhich do one thing

well, andcan link to otherprograms

which do something elsewell. So, for

example, pressing Enterwill getyou

to EyeOfGnome, which can do full-

screen slideshowsofimages.

Two Cents On Unity

I am a 45-year-old career
software developer, on a
sabbatical for a while, with
around 3 years under my belt

as an Ubuntu user. Total
Linux/FOSS convert and a vocal

local advocate.

My experience of Linux has
been one of freedom and all the
possibilities it presents. We are
free to use pretty much whatever
device we want, any way we want
to use it, with whatever
distribution and/or software
packages that suit, and contribute
back in whatever capacity we can.
After working for years in technical
silos, this freedom shines very
bright.

Many of the contributions to
the Unity debate do not seem to
appreciate one important factor:
each person's own unique way of
working with Ubuntu. I currently
use a classic 11.04 desktop as my
setup has evolved, due in no small
part to the contributions in FCM,
into a system that very nicely fits
how I use my PC/laptop. In all my
years, no other setup has come
anywhere near it in terms of
usability. I have tried Unity a few
times, and found it doesn't suit me.
That does not make me right or
Unity wrong. It just does not work
for me.

This is where the beauty of the
freedom of Linux kicks in. Unity is
just another idea in the world of
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Linux, and, if it does not suit, then
you are free to chose another way.
So, either when push comes to
shove, or I find the inclination and
time, I will go looking for a
distribution that performs at least
as well as my current setup.

Whilst the exploration of new
software and distributions can be
an enjoyable aspect of Linux, when
you find a setup that works for you
- and, just as importantly, your
hardware - you become reluctant
to make big changes. After all, it is
what we do with the technology
that counts, not how we do it.

Gerard Nash

Software Center Sync

The latest version of the
Ubuntu Software Center,
found in Ubuntu 11.10,
has an interesting new

feature, synchronizing between
computers. This can be used in
many ways, but, primarily to
compare two Ubuntu installations,
note which software is installed or
missing from the other installation,
and then the ability to install the
various missing packages onto the

current Ubuntu installation.

Here's the problem.

Whether you're synchronizing,
or just singly manually selecting
and installing software from the
Ubuntu Software Center, there's no
"queue" to stack up desired
packages to install. It starts
installing the first package
immediately, and, as other
packages are selected for
installation, they are prepared for
their turn to be installed. With each
package selected to install, the
whole system gets slower and
slower. And, if performing this
using the sync feature, after every
package selection, it repaints the
entire screen showing the list of
missing packages, but positioned
at the top of the list, not where you
left off. This requires the user to
manually scroll all the way down to
the prior position to continue
reviewing other packages.

What needs to be done is to:

1.) allow the user to stop the
queue, and select any/all of the
packages they desire to install.
That selection would get added to
the stopped queue, and, when the
user has finished selecting all of

their desired packages to be
installed, they can start the queue,
and go get some coffee while the
Ubuntu Software Center performs
all of the installations, without
delay, or further user intervention.

2.) when reviewing and selecting
software to install, the list of
software should return to the
position that the user left it in,
after selecting a package to install.

3.) the user should be able to print
a list from the sync function, that
displays software added/missing
from one Ubuntu installation vs
another.

4.) there should be a user pref that
allows the Ubuntu Software Center
to be the default installation
device, or the original gdebi
installer to be used as the default.

Al Heynneman

Well Rounded

While I am not a super
user in the Linux
world, I am well
rounded. All puns

intended. I have used PCs, and
Macs since Macs had a handle on
top. Both platforms make local
folder sharing pretty darn easy,
and my home has many computers
in it. Why is it always a crapshoot
getting a Ubuntu machine to share
and/or connect with other
machines in the house. I can see all
the other platforms shares but
cannot connect. And I manage to
mess up Samba every time. Sharing
a folder on a MAC is super easy.
PCs and other Macs have no
problem accessing the folders. My
movie Linux machine (hooked up to
the TV), and an old Netbook (linux)
- no go. Frustrating to say the least.
Can someone give me a simple file
sharing option? The easiest thing
would be for the Desktop Linux
Movie player box to be available to
Windows PCs, Macs, and the
Netbook. Both Linux machines
have the latest Ubuntu Installed
and updated.

Mike Todd



full circle magazine #59 44 contents ^

PPUUZZZZLLEESS
If you would like to submit a puzzle for publication, please
email it to: letters@fullcirclemagazine.org. Solutions are on
the second last page of this issue. No peeking!

The solutions to all the puzzles are on the
second last page of this issue. No peeking!

Across:
2. Very massive warehouses start off with this emulator (6)
4. Speak rapidly with word starter on a microblogging client (7)
5. Dreamy, like 11.10 (7)
8. Media center OS - is it real, or like an unicorn(9)
13. Spanish insanity for linux users in a neighbourhood, maybe?
14. A definite anteater?(7,8)
15. None confirms hides, synchronizing mechanism for Ubuntu One
(7)
16. An implementation of the S.C.U.M.M. interpreter for Linux (7)

Down:
1. Sail by turbidity for an OS for Muslims (6)
3. Painter unknown gives an OS for graphics (7)
6. Say Ubuntu, speak this language (5)
7. Jaded up, unraveled for a backup tool (4,3)
9. The Debian almquist shell or short sprint (3,4)
10. To run Linux commands on a windows system, turn back New
York city and put a wig in! (6)
11. Jumpy? OS for users in Quebec (9)
12. Test total for hash sum (8)
13. They may be convex, concave, or in the Unity interface (6)

Crossword by Ilavenil Thirumavalavan

mailto:letters@fullcirclemagazine.org
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QQ&&AA
Compiled by Gord Campbell

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

Q When I replaced 32-bit
Ubuntu with 64-bit, the
amount of available RAM
decreased by 100MB

(went from 3.9GB in 32-bit to
3.8GB in 64-bit). Why?

A The computer's video
adapter steals RAM, and
the amount increased
from 128 MB to 256 MB.

Q My computer has a 250
GB HDD. If I look at Disk
Usage Analyser, it tells
me the total filesystem

capacity is 244 GB, but if I look at
System Monitor it tells me the total
is 227.3 GiB.

A 244 GB = 227 GiB. You
can try it yourself: 227.3
x 1024 x 1024 x 1024 =
244 GB. Marketing

people want the bigger number.

Q I'm using ripperx, but the
only options that are
offered are for mp3 and
wav. How can I use this to

rip into flac?

A Install the flac package
with Synaptic, then open
ripperx and hit the
Config button; under the

mp3 tab, change the Encoder
plugin to Flac.

Q When I ran a script, it
stopped at this line:

mdb $(echo 'hostname') return

site > __temp.out

A Mdb is the Mono
debugger, which wants
input from the keyboard.
You have directed the

output to a file, so you can't see
what it wants.

Q How can my Dell
Dimension 2350 boot
from USB?

A Plop Boot Manager will
fit on a floppy, and can
chain to a bootable USB
device.

http://www.plop.at/en/bootmanag
ers.html

Q Can I run Ubuntu with no
hard drive at all?

A Yes, you can use a
LiveCD or a LiveUSB. You
could even install
Ubuntu to a flash drive,

and run from that.

Q I finally have TVTime
working on my AMD64
machine. However,
Update Manager keeps

suggesting a later version, which
does not work for me. How can I
force the system to stay with the
currently installed version?

A Install Synaptic Package
Manager. Run Synaptic,
and search for TVTime.
Click on the package,

and select, "Lock Version."

Q What is going on with
Sun Java 6?

A Have a look at this site:
http://www.ubuntugeek.
com/install-sun-java-6-in-
ubuntu-11-10-using-

ppa.html

However, it is probably better
to install OpenJDK Java 7, which
includes icedtea-plugin and
openjdk-7-jre. See
http://www.futuredesktop.org

Q How can I get a list of
computers on my
network?

mailto:questions@fullcirclemagazine.org
http://www.plop.at/en/bootmanagers.html
http://www.ubuntugeek.com/install-sun-java-6-in-ubuntu-11-10-using-ppa.html
http://www.futuredesktop.org
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Q & A

A If you have Samba
installed, you can use the
command: smbtree

Q When I try to reduce the
brightness on my laptop
using System Settings, it
doesn't change.

A Open a Terminal, and
enter this command:

xgamma ­gamma .5

You can try different values
than .5, to see what works for you.

Q In Kubuntu 11.10, when I
try to run Software
Update, I get the
message that another

package manager is running.

A The magic incantation:

sudo dpkg ­­configure ­a

sudo apt­get install ­f

Reboot, and run Software
Update.

Q I occasionally need to
build something from
source (I'm sure we all
do), for whatever reason.

I'd like to have these programs
show up in Unity's dash search, like
apps installed from the Software
Center.

A (Thanks to stinkeye in
the Ubuntu Forums) If
you add it to alacarte
(main menu), dash will

pick it up. You may need to install
alacarte.

Q I have a Toshiba Satellite
L645D. Whenever I hit the
power button, it
immediately bounces

directly into loading Ubuntu; how
can I boot from CD?

A (From the Original
Poster) Apparently,
pushing F2 needed to
begin BEFORE the power

button.

Gord adds: on other computers, the

magic key is ESC, DEL, F1, F2, or
F12.

Two Tips and
Techniques
Move forward soon!

I see a lot of people who have
major problems when they are
using an elderly version of Ubuntu.

A lot of hardware has appeared
since the last Long-Term Support
release, Ubuntu 10.04. It's not
realistic to expect this hardware to
be supported by an operating
system which predates it.

Even with hardware from before
then, there may be issues. For
example, Ubuntu 10.04 (and
previous versions) often didn't
switch between built-in speakers
and earphones properly. For many
sound adapters, the problem has
been solved in later versions.

As this appears, we are a month
away from another Long-Term
Support release, Ubuntu 12.04. I'm
going out on a limb here, and
suggest that everyone should
install the latest version, certainly
by mid-summer. Some people don't

want to deal with the Unity user-
interface. They have options:
Kubuntu 12.04, Lubuntu 12.04,
Xubuntu 12.04, or Linux Mint 13.

If you don't know what to do,
plunk down $6 (or equivalent) for a
4 GB flash drive, download some of
those versions, and see which one
tickles your fancy. The only option
which is unacceptable, is sticking
with an obsolete OS.

Everything you know
about drivers is wrong

"My computer does not have
Internet access. Can I download
drivers to my stick on an Internet
machine and then load them on the
Linux system?

"Where would I go for drivers
after I get the basic load to work?"

Most of what you know about
drivers no longer applies. However,
it's one area where it's a lot easier
if you have an Internet connection.

Most drivers come along with
the kernel. Let's talk about four
kinds of drivers: video adapter,
WiFi adapter, printer, and webcam.
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For the first two, people
normally run a program called
"Additional Drivers," which will tell
them if there are video or WiFi
drivers available to install.

WiFi is a special case: many
adapters are supported "out of the
box," no need to install a driver.
Others have a driver two clicks
away in Additional Drivers
(assuming an Ethernet connection
to the Internet,) some need the
Windows driver under something
called NDISWrapper, and some will
never work. If the first two options
don't work for you, get busy with
Google.

Printers: when I install any
recent version of Linux, I turn on
my network printer and run a
program called "printers," and click
on "add." A couple of clicks later, it
scurries off to the Internet and
installs the appropriate driver, and
the printer works. Barring that
approach, you go to the
manufacturer's web site and collect
the Linux driver, along with other
required software. PITA.

In my experience, webcams
either work or they don't. My
specialty is cheap webcams

purchased in China, and they have
all worked for me "out of the box,"
except with Ubuntu 10.10, which
required an unusual incantation.

Oddly, some of the nastiest
driver issues are with hardware
which was on the drawing board
last week. Even something as
simple as an Ethernet adapter
might not be supported until it has
been around for a few months, and
all you can do is wait for it. (Or plug
in an older Ethernet adapter in the
short term; they're cheap.)

Q & A

After a long career in the computer
industry, including a stint as editor of
Computing Canada and Computer
Dealer News, Gord is now more-or-
less retired.

Z e r o D o w n t i m e

Below Zero is a Co-located Server Hosting specialist in the UK.

Uniquely we only provide rack space
and bandwidth. This makes our service
more reliable, more flexible, more
focused and more competitively priced.
We concentrate solely on the hosting of
Co-located Servers and their associated
systems, within Scotland's Data
Centres.

At the heart of our networking
infrastructure is state-of-the-art BGP4
routing that offers optimal data
delivery and automatic multihomed
failover between our outstanding
providers. Customers may rest assured
that we only use the highest quality of
bandwidth; our policy is to pay more for the best of breed providers
and because we buy in bulk this doesn't impact our extremely
competitive pricing.

At Below Zero we help you to achieve Zero Downtime.

w w w. ze ro d ow n t i m e.co. u k

http://www.zerodowntime.co.uk
http://belowzero.biz
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UUBBUUNNTTUU GGAAMMEESS
Written by Riku Järvinen SSNNEESS EEmmuullaattoonn

Hi all! This month starts a
series of articles on
bsnes, a cross-platform
Super Nintendo

emulator that aims for maximum
accuracy with no hacks or cheats,
focusing on clean code. According
to the project homepage
(http://byuu.org/bsnes), this comes
with an additional computational
strain. They say that Bsnes requires
at least a Core 2 Duo or an AMD
Phenom processor to run
smoothly.

In this issue, bsnes installation
(v. 0.84), ROM downloading and
cleaning, and basic features of
bsnes are discussed on Ubuntu
Oneiric 11.10 32-bit. A certain
familiarity with emulation is
assumed, but you also can pick up
this knowledge along the way. The
goal of these articles is to get the
games running well with minimal
non-necessary technical overhead.

Bsnes installation: a
workaround with .deb
files

As I was searching the web for
bsnes installation tutorials, I came
up short with a single good one.
Instead of compiling the source
code and delving into techie stuff, I
present a workaround with .deb
files that is both easy to implement
and works like a charm. bsnes
version 0.84 is used since it will be
included in Precise 12.04 LTS.

To begin with, you should have a
few developer tools installed. If
not, paste the following into a
terminal window. Give your
password when prompted.

sudo apt­get update

sudo apt­get install build­

essential gcc­4.6 g++­4.6

libgtk2.0­dev libqt4­dev

sudo apt­get install

libsdl1.2­dev libpulse­dev

libopenal­dev libao­dev

libxv­dev

Next, open Firefox and go to
Ubuntu Updates for Bsnes
(http://www.ubuntuupdates.org/p
ackage/core/precise/universe/base
/bsnes). Select and download the
32-bit .deb package (assuming you

have a 32-bit system) and navigate
into your Downloads folder. Install
bsnes with:

sudo dpkg ­i bsnes_0.084­

1_i386.deb

If all goes well, you should now
be able to run bsnes from Unity
Dash by typing “bsnes” and
selecting the application. Once
bsnes is running, you can select
between Cartridge, Settings and
Tools from the top panel. Now, let’s
take a look on where to download
ROMs and how to “purify” them.

Downloading ROMs &
ROM Cleaning

While there are plenty of sites
to get ROMs, keep in mind that you
must delete the files after 24 hours
if you do not own the original
cartridges. In case you want to

keep playing, there are plenty of
originals available on eBay and
similar web auctions.

After downloading, the ROMs
must be “cleaned” of additional
copier header information (for a
more accurate explanation, refer
to bsnes user guide
(http://byuu.org/bsnes/user-guide).
Unlike some mainstream
emulators, bsnes doesn’t support
compressed (.zip) or Super
Magicom (.smc) files. Before
playing games, we need to use
snespurify, an utility included with
bsnes installation. Open Unity Dash
and type “snespurify” and select
the application. Choose the folder
you wish to scan for ROMs (most
likely Downloads if you got the
ROMs from the web) and click
“Correct”. It should take only a
couple of seconds to reconfigure
the files. Once the process is
finished, you can choose a game to

http://byuu.org/bsnes
http://www.ubuntuupdates.org/package/core/precise/universe/base/bsnes
http://byuu.org/bsnes/user-guide


full circle magazine #59 49 contents ^

Riku Järvinen (rierjarv) is a CS major
student from Finland who delves into
the Linux and Open Source gaming
world once in a while.

UBUNTU GAMES - SNES EMULATION
play from the bsnes Cartridge
menu.

Some basic settings

It is unlikely that bsnes runs
perfectly “out of the box”. There
are many settings to be customized
and we will take a closer look at
them in the next issue. However,
here are some tips to get the basic
functionality right. Keep in mind
that some settings are machine-
and game-specific, so adjust the
program as you see fit. All settings
that are not mentioned should be
left as default.

Settings ­> Configuration ­>

Audio: Frequency 44.1kHz,

Latency: 40 ms, Resamp.

Hermite

Settings ­> Configuration ­>

Advanced: Video OpenGL, Audio

PulseAudioSimple

Settings ­> Configuration ­>

Input ­> Snes: Cont. port

(define your controls)

One of the great things is that
you can modify graphics settings
without restarting the ROM. This
speeds up things considerably,
because you see the effect right
away. Experiment with different
Video Filters and Shaders if you
want to put your machine to the
test. Filters, especially, require lots
of resources.

Introducing an USB gamepad
was easy from the Input settings: it
worked straight out of the box.
Once, my settings disappeared and
I had to reconfigure the controller,
but there have been no problems
since.

First Impressions

I tested bsnes with: Chrono
Trigger, Donkey Kong Country,
Lufia 2, Super Mario All-Stars, Final
Fantasy 6 and Mega Man X. As a
gamer with more than 200 hours of

zsnes (http://www.zsnes.com)
experience, I must confess that
bsnes does a much better job when
it comes to accuracy and quality of
emulation. However, this comes at
a hefty computational price. On my
desktop (E6750 Core 2 Duo, 4 GB
DDR2, GeForce 8800 GTS, 320 MB
and 1 TB HDD) there is still a
noticeable slow-down. I might
consider upgrading the graphics
card, although I’m not completely
sure whether it’s causing the
problem.

More information

If you wish to know more, grab
the next issue of FCM when it
comes out next month. Meanwhile,

I encourage you to visit the bsnes
homepage (http://byuu.org/bsnes).
Developer Byuu has written a great
deal of in-depth information on
snes emulation as well as other
software-related topics.

In the next issue, I focus on
more advanced bsnes settings and
tell how to edit the configuration
files manually using a text editor.

http://byuu.org/bsnes
http://www.zsnes.com
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With the recent
plethora of RPGs
released for the
major consoles, I

can’t help but get a little envious
and anxious for an in-depth role
playing game for Linux. Luckily for
us Ubuntu gamers, the developers
at Kot-In-Action are working on an
exciting first-person RPG called
Tomes of Mephistopheles (ToM).
The game is currently in alpha, and
you can help fund the development
and buy the full, DRM-free game at
the official Kot website
(http://tom.kot-in-action.com) or
through Desura. I recently had the
pleasure of chatting with
Alexander Zubov, co-creator of
ToM as well as the 2010 hit series,
Steel Storm. Alexander was
gracious enough to share some
details on his new project and
some thoughts on what’s in store
for Kot-in-Action in the near future.

When and how did you get
started with Kot-in-Action
Creative Artel?

Kot-in-Action Creative Artel was
founded in 2008, prior to the
QuakeExpo 2008 virtual event. I

learned about the DarkPlaces
game engine years prior to the
event, and I wanted to make a
standalone game using it. The role
of art director and all-round artist
was a natural choice as I come from
an art and graphic design
background. I began working on my
first game titled Prophecy: Return
of the Blademaster, and soon I
realized I needed a coder to help
me with the project. No one
wanted to help me as the project
was in pre-production stage at that
time. Seeing that help was not
coming, I rolled up my sleeves and
got to coding the game myself. The
project was doing great and I
wanted to display it at Quake Expo.
However, I really wanted for it to
shine, so to speak, and I asked for
help once again. This time around,
one of the most prominent coders
in the Quake modding community,
Clay "daemon" Cameron, offered
his skills to help out Prophecy. Kot-
in-Action team was formed, and
the prototype of the game was put
together in just 3 weeks prior to
Quake Expo. The reception of
Prophecy by the Quake modding
community was warm, and we

decided to turn it into a
commercial game. Although we
had some experience in modding,
making a full commercial game was
a whole different story. Prophecy
required a lot of art assets. Since
we didn't really know our potential,
we decided to come up with a
game of smaller scale. Steel Storm
was born and the rest is history.

Tell us all about Tomes of
Mephistopheles.

Tomes of Mephistopheles is
designed to be a first-person

action-RPG dungeon crawler with
randomly generated worlds and
dungeons. It will have fast-paced
fluid combat (inspired by such old
school games as Hexen/Heretic), a
multitude of medieval and magical
weapons, and an in-depth custom
spell system (not something you
see in many RPG games). Players
will be exploring vast dungeons in
search of the ancient Tomes. On his
(her) way, the player will fight a
variety of monsters, look for
items/gear/weapons, discover
secrets, solve quests, improve his

UUBBUUNNTTUU GGAAMMEESS
Written by Jennifer Roger TToommeess ooff MMeepphhiissttoopphheelleess

http://tom.kot-in-action.com
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UBUNTU GAMES - ToM INTERVIEW
(her) skills, develop new spells, and
master new weapons. Players will
be able to craft gear, weapons, and
spells, and use dug-out cavities as a
shelter / safe house. Dungeons and
other structures are destructible
via a multitude of means, and
connect with a surface or outdoor
over-world which connects to
multiple other dungeons.
Dungeons can also connect to each
other, and if a connection does not
exist, the player can dig his way
through. The surface and dungeon
areas will have towns and/or
encampments with structures,
NPCs, and various creatures to
interact with. Not only that, but
characters will not be limited to a
single world. Players can generate

new dungeons and continue
building up their character, or take
that character online to another
player's world and partake in player
vs player combat, cooperative
questing, or possibly even help
build some kind of structure
depending on what the owner of
the server allows.

What are some upcoming,
post-alpha features to look out
for?

We are planing to add more
architectural details so the
dungeon won't look so empty.
Player progress saving and
dungeon saving are on their way.
Multiplayer. More enemies, gear,
and weapons. Multifloor dungeons.

These features are due in the
nearest future.

What have you learned from
creating Steel Storm that you've
incorporated into creating ToM?

Release early and iterate. No
localization support (everyone
knows English to a certain degree,
and coordinating translations of
constantly changing and improving
text is a huge overhead). No Mac
support until release (we don't
have Macs, and, while the engine
runs on Mac, testing without
having a Mac handy has proven to
be a disaster). Use social media as
much as possible. Reuse the
resources.

Will there be future
installments/episodes (ala Steel
Storm) or DLC?

Most likely we will have DLC,
pre-built characters, and some
unique gear and gadgets, after the
game is released. It's too early to
talk about future installments,

although the potential is there.

Can you tell us about your
plans after ToM is released? Any
new games or focusing on DLC?

We already have Steel Storm 2
in development, along with ToM,
so I think we are pretty much set
for the mid-range foreseeable
future.

Thanks again to Alexander
Zubov for participating. For more
information on Tomes of
Mephistopheles, you can visit
http://tom.kot-in-action.com for
more screen shots, videos, and
game updates.

http://tom.kot-in-action.com
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MMYY DDEESSKKTTOOPP

I'm Italian and this is my desktop with my holiday's image....
today.

I have a laptop, Fujitsu-Siemens Amilo Li3710 with 4GB ram,
one CPU dual core Intel Pentium t3400 2, 1.6GHz, HD 300 GB,
and ubuntu 11.04(natty).

I've also used Avant window navigator 0.41 and Gartoon icons
from the Ubuntu repository.

Perfect!

Paolo Gagini

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

I use Kubuntu 11.10 with the KDE 4.7.2 desktop environment.
I have used a couple of widgets on the desktop. You can see
my home folder and my desktop folder both on top, easily
reachable to do what needs to be done. Pictures from the last
holiday in the USA, a clock, an RSS widget with news from a
Dutch news website, information about my disks and network
and, very important here in Holland, the weather. The
Shutdown/Restart/Log-off button completes it.

In the panel, I have my 4 desktops, the Task manager to see
which programs are open, some launchers, and the usual
information you sometimes need. It's all very basic, but hey,
that's me.

Jan Mussche

mailto:misc@fullcirclemagazine.org
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MY DESKTOP

The computer is a homebuilt computer from 2003. The CPU is
an AMD Athalon 1800 XP+ and it has 2GB DDR-266 RAM in it.
The video card is an EVGA GeForce 6200 AGP 8x card. I'm
running Ubuntu 11.10 with Unity 3D. The wallpaper is the
"Verne" wallpaper from the Fedora 16 Live CD. The theme is
"Smoke & Ice" from softpedia.com, I have the settings for the
theme showing in the Advanced Settings app. In the terminal, I
used the .bashrc and .envrc from http://bodhizazen.net (under
his Tweaks), and the message is from display-dhammapada
(available via apt-get).

Originally I was going to try and find a theme that matched the
Verne wallpaper, but this looked interesting in their
screenshots. For some reason, it shows up as Raleigh in the
Advanced Settings.

Patrick Dickey

This is my Desktop screenshot. I am running Ubuntu 10.10
Maverick Meerkat decorated by Ambiance Theme with
Faenza icons, AWN, Indicator Applet Application Menu 0.4.6,
and more cool customized themes. My PC is optimized for
graphic design and Internet. Kernel Linux 2.6.35-31, Gnome
2.3.2.0 Desktop Manager, and Compiz Fusion 0.82 are the
core of my amazing OS on this PC.

PC Specs:
Acer ASPIRE M1800 with Intel(R) Pentium(R) Dual Core CPU
E5200 @2.5 GHz
2GB DDR2-RAM, nVIDIA GeForce 7100 GPU @256 MB, 2 x
320 GB SATA HDD & DVD.

Badrus Shava

http://bodhizazen.net
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PUZZLE SOLUTIONS
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HHOOWW TTOO CCOONNTTRRIIBBUUTTEE

We are always looking for new articles to include in Full Circle. For article
guidelines, ideas, and for issue translation, please see our wiki:
http://wiki.ubuntu.com/UbuntuMagazine
Please email your articles to: articles@fullcirclemagazine.org

Full Circle Team

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Comms Mgr - Robert Clipsham
mrmonday@fullcirclemagazine.org
Podcast - Robin Catling
podcast@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy
Lucas Westermann
Gord Campbell
Robert Orsino

Our thanks go out to Canonical, the
many translation teams around the
world and to Thorsten Wilms for the
current Full Circle logo.

If you would like to submit news, email it to: news@fullcirclemagazine.org

Send your comments or Linux experiences to: letters@fullcirclemagazine.org

Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org

Questions for Q&A should go to: questions@fullcirclemagazine.org

Desktop screens should be emailed to: misc@fullcirclemagazine.org

... or you can visit our forum via: www.fullcirclemagazine.org

Deadline for FCM#58:
Sunday 08th April 2012.

Release date for FCM#58:
Friday 27th April 2012.FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no exception. We need
your Opinions, Desktops and Stories. We also need Reviews (games, apps &
hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or
suggestions, you may have.
Send them to: articles@fullcirclemagazine.org

http://wiki.ubuntu.com/UbuntuMagazine
http://ubuntuforums.org/forumdisplay.php?f=270
mailto:news@fullcirclemagazine.org
mailto:letters@fullcirclemagazine.org
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mailto:admin@fullcirclemagazine.org
mailto:mrmonday@fullcirclemagazine.org
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